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About this publication

This publication describes in detail how to use the IBM Software Development Kit
for Multicore Acceleration Integrated Development Environment for Cell

Broadband Engine" (IDE).

Who should use this book

The target audience for this document is application programmers using the IBM
Software Development Kit for Multicore Acceleration (SDK). You are expected to
have a basic understanding of programming on the Cell Broadband Engine

(Cell/B.E.) platform and common terminology used with the Cell/B.E. platform.

Typographical conventions

The following table explains the typographical conventions used in this document.

Table 1. Typographical conventions

Typeface

Indicates

Example

Bold

Lowercase commands,
library functions.

void sscal_spu ( float *sx,
float sa, int n)

Italics

Parameters or variables
whose actual names or
values are to be supplied by
the user. Italics are also used
to introduce new terms.

The following example
shows how a test program,
test_name can be run

Monospace

Examples of program code
or command strings.

int main()

Related information

For a list of SDK documentation, see [Related documentation|

How to send your comments

Your feedback is important in helping to provide the most accurate and highest
quality information. If you have any comments about this publication, send your
comments using IBM Resource Link " at fhttp:/ /www.ibm.com/servers/|

Click Feedback on the navigation pane. Be sure to include the name
of the book, the form number of the book, and the specific location of the text you
are commenting on (for example, a page number or table number).

© Copyright IBM Corp. 2006, 2008
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Part 1. Getting started

These topics describe what IDE is, the hardware requirements and how to install
IDE.

* |Chapter 1, “Overview of the IBM SDK for Multicore Acceleration Integrated|
Development Environment,” on page 3|

* |Chapter 2, “Supported operating environments,” on page 5|
* [Chapter 3, “Installing IDE,” on page 7|
* |Chapter 4, “Uninstalling IDE,” on page 11|

© Copyright IBM Corp. 2006, 2008
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Chapter 1. Overview of the IBM SDK for Multicore
Acceleration Integrated Development Environment

The IBM® SDK for Multicore Acceleration Integrated Development Environment
(IDE) is built upon the Eclipse and C Development Tools (CDT) platform.

It integrates the Cell/B.E. GNU tool chain, compilers, IBM Full-System Simulator
(simulator) for the Cell/B.E. processor, and other development components to
provide a comprehensive, user-friendly development platform that simplifies
Cell/B.E. application development. The key features include the following;:

¢ A C/C++ editor that supports syntax highlighting, a customizable template, and
an outline window view for procedures, variables, declarations, and functions
that appear in the source code

* A rich visual interface for the Power Processing Element (PPE), Synergistic
Processing Element (SPE), and the GNU debugger (GDB)

* A seamless integration of simulator into Eclipse

* An automatic builder, performance tools, and several other enhancements

© Copyright IBM Corp. 2006, 2008 3
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Chapter 2. Supported operating environments

The following are the prerequisites for using IDE for all operating environments.
Architecture: x86, x86_64, PPC, PPC_64, Cell/B.E.
Operating System: Linux®

Software:
+ |Cell BE SDK 3.1|

s Java 1.5 or )

Note: The Java™ that comes installed in some Linux® installations (GCJ) is not
sufficient.

© Copyright IBM Corp. 2006, 2008
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Chapter 3. Installing IDE

This topic describes how to install IDE.

If you have installed the SDK and wants to use the optional IES Eclipse IDE
component, install IDE by following these steps:

1. The GCJ JRE installed with Linux distributions is not sufficient for IDE.
Download and install J2SE Version 5.0, SR8 or greater for 32-bit xSeries® from
[rttp://www.ibm.com/developerworks/java/jdk/1inux/download.html} SDK
provides an IBM 32-bit JRE 1.5 SR8 that you can install by invoking the
following commands as root (admin):

* yum install ibm-java2-ppc-jre (PowerPc version)
* yum install ibm-java2-i386-jre (i386 version)
2. Configure your environment to use the new JRE.

a. Eclipse uses the Java virtual machine (JVM) to which your Linux PATH
variable points. To find out which version of Java is being used, run the
command:

java -version

If this returns a JVM other and GCJ, you can go to next step.

b. When you start Eclipse, use the -vin command to specify the IBM JVM. For
example:
eclipse -vm /opt/java/jdkl.5.0 _08/jre/bin

c. If you want to modify your environment permanently, configure your PATH
variable to reference the IBM JVM. You can modify your PATH variable by
editing the file $HOME/ .bash_profile. For example, add this line:
PATH=$HOME/bin:/opt/java/jdk1.5.0_08/jre/bin:$PATH

3. Install the IDE rpm. To install the IDE rpm, log in as root (admin) user and
perform one of the two installation methods:

* Download the rpm from the [developerWorks® IDE site} To install it, use the
rpm command:

> rpm -ivh cellide-3.1.0-[RELEASE_NUM].[ARCHITECTURE].rpm
* If you have the cell-install rpm installed, you can use yum as follows:

> yum install cellide
This procedure installs an IES Eclipse bundled with CDT 4.0, PTP Remotetools
2.0 and the latest IDE plug-ins into the /opt/cell/ide/eclipse directory.

4. Install the Accelerated Library Framework (ALF) IDE template, Performance
Debugging Tool (PDT) and SPU Timing packages.

a. If you want to use the ALF IDE Wizard, you need to install the ALF IDE
template rpm (alf-ide-template). Make sure you have the SDK’s cell-install
rpm package installed, then invoke the following command:

> yum install alf-ide-template

b. To enable the PDT feature on IDE, make sure you have the SDK's
cell-install rpm package installed, then invoke the following command:

yum install pdt

c. To use the SPU Timing feature, make sure you have the SDK’s cell-install
rpm package installed, then invoke the following command:

© Copyright IBM Corp. 2006, 2008 7
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yum install cell-spu-timing
What to do next: For more information about IDE, see the Eclipse help topic.

To access IDE help, in Eclipse, click: Help + Help Contents » IDE for Cell
Broadband Engine SDK.
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Troubleshooting: 32-bit IES Eclipse fails to load on 64-bit Fedora 9

This occurs because there are no specific 32-bit libraries provided with the Fedora
9 x86_64 version.

Solution:

1. Install the cellide package.

2. Install libcairo 32-bit version:
yum install libcairo.i386

3. Install libXtst 32-bit version:
yum install TlibXtst.i386

Chapter 3. Installing IDE 9



Troubleshooting: 32-bit IES Eclipse fails to load on x86 with RHEL 5.2

This is a known issue caused by a library called xulrunner. The original installation
of this library in RHEL 5.2 makes 32-bit IES Eclipse to crash. To solve this problem,
remove the original version of xulrunner from your RHEL 5.2 installation:

yum erase xulrunner

10 IDE Tutorial and User’s Guide Draft



Chapter 4. Uninstalling IDE

This topic describes how to uninstall IDE for all platforms.

To uninstall IDE, you must remove the cellide package from the system. You can
do this in many ways, for example:

¢ As root user, issue the command:
yum erase cellide

* Use any graphical packaging management tool to remove the cellide package

When you remove the cellide package, the following components are deleted:
* IES Eclipse bundled with CDT 4.0 and PTP Remotetools 2.0
¢ The IDE plug-ins installed in the /opt/cell/ide/eclipse directory

Note: The IDE uninstallation process does not erase any plug-ins or workspaces

located on the user’s space, but it does erase all the contents of
/opt/cell/ide/eclipse and its subdirectories.

© Copyright IBM Corp. 2006, 2008
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Part 2. Using IDE

These topics describe how to use IDE to run and debug applications.

It describes the following topics:

* |Chapter 5, “Creating a Cell/B.E. environment,” on page 15|

* |Chapter 6, “Running IDE on Cell/B.E. systems,” on page 17

* [Chapter 7, “Running IDE on Power-PC systems,” on page 21|
+ |Chapter 8, “Using the CDT XLC error parser,” on page 23|
* |Chapter 9, “Configuring public key-based authentication using OpenSSH,” onl|

page 25|

[Chapter 10, “Troubleshooting and work-arounds,” on page 27

© Copyright IBM Corp. 2006, 2008
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Chapter 5. Creating a Cell/B.E. environment

This topic describes the Cell/B.E. environments in which you can run IDE.

You can use IDE to run and debug Cell/B.E. applications in any of the following
types of Cell/B.E. environments:

Attached Cell/B.E. simulator - Cell/B.E. simulator running on a remote system.
You must manually start the simulator on the remote system. This is different to
the remote Cell/B.E. simulator environment, where IDE starts the simulator on
the remote host.

Cell/B.E. box - Physical Cell/B.E. system (remote or native Cell/B.E. system
running IDE).

Local Cell/B.E. simulator - Cell/B.E. simulator running on the native system.
Remote Cell/B.E. simulator - Cell/B.E. simulator running on a remote system.
IDE starts the remote simulator. This is different to the attached Cell/B.E.

simulator environment, whereby you must start the simulator manually on the
remote host.

Before you can run or debug a Cell/B.E. application, you must create and start a
Cell/B.E. environment as following:

1.
2.

Open the Cell Environments view.

Right click any of the four available Cell/B.E. machine types, then select
Create.

Enter any necessary configuration values, then click Finish.
Start the environment. To do this, click the green Start arrow button.

After the Cell/B.E. environment has started, it is ready to be used for Cell/B.E.
application deployment.

More information:

[Running IDE on Cell/B.E. systems|
[Running IDE on Power-PC systems|

© Copyright IBM Corp. 2006, 2008 15
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Chapter 6. Running IDE on Cell/B.E. systems

IDE can be run on a system with a Cell/B.E. processor (as of version 3.0).

The following topics describe how to run IDE on such a system:

+ ["“Managing builder paths for Cell/B.E. systems”]

* |"“Debugging Cell/B.E. applications’|

* [“Running Cell/B.E. applications” on page 19|

Managing builder paths for Cell/B.E. systems

The GNU and XL tool paths are at different locations on a native Cell/B.E. system
than on a "typical”, non-Cell/B.E. system. IDE’s default paths reflect the default
Cell/B.E. SDK tool paths of a non-Cell/B.E. computer, so these paths must be
corrected. This can be done as follows:

1. After [installing IDE] open Eclipse preferences. To do this, click Window -

Preferences.

2. Open the GNU Tools Managed Build Paths preference page: Cell + Managed
Builder Paths + GNU Tools Managed Build Paths.

3. Click Find it! to automatically find the GNU tools location, or click Browse to
manually select the location

4. Do the same for the XL Tools Managed Build Paths preference page
Debugging Cell/B.E. applications

Debugging Cell/B.E. applications while running the IDE on a native Cell/B.E.
machine requires a few changes to the debugger configuration in order to function
properly. Unlike attempting to debug Cell/B.E. applications remotely via SSH,
debugging locally does not require the use of gdbserver. Also, instead of creating a
C/C++ Cell Target Application debug configuration, you can simply create a
C/C++ Local Application configuration (see [Figure 1 on page 18).

Note: Other debugger configurations and combinations are possible, only one of
them is described here.

1. Click Run » Debug... to open the debug configuration window.

2. Create a new C/C++ Local Application debug configuration (Figure 1 on page

i),

© Copyright IBM Corp. 2006, 2008 17



* Debug =1 5%

Create, , and run gurations ﬁ

| B I Configure launch settings from this dialog:
[frype ficer text] | | - Press the 'New' button to create a configuration of the selected type.

[E] Cic++ Attach to Local Application i - Press the ‘Duplicate’ button to copy the selected configuration.
& C/C++ Cell Target Application ¥ - Press the 'Delete’ button to remove the selected configuration.

7 - Press the 'Alter button to configure filtering options.
[£] C/C++ Postmortem debl - Edit or view an existing configuration by selecting it.
@ Eclipse Application |
# Equinox OSGi Framework Configure launch perspective settings from the Perspectives preference page.
[ Java Applet
51 Java Application
Ju Junit

Jii Junit Plug-in Test
[, Remote Java Application

SPU Timing (Standard Make Projects)
[ sWT application

@ | mebig || Close |
Figure 1. Creating a new C/C++ Local Application

After you have created a new C/C++ Local Application launcher, you must
properly configure the Debugger tab (see [Figure 2 on page 19):

1. Select the gdb/mi debugger.

2. Change the GDB Debugger to ppu-gdb in order to be able to debug the SPU
parts of the application as well as the PPU part.

3. Change the GDB command set field to Standard (Cell BE).
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[El cic++ Attach to Local Application
& C/C++ Cell Target Application
= [E] C/C++ Local Application
| gsmpe
[€]ciC++ Postmortem debugger
@ Eclipse Application
£ Equinox O5G] Framework
2 Java Applet
[T Java Application
Ju Junit
Ji JUnit Plug-in Test
=, rRemote Java Application
SPU Timing (Standard Make Projects)
=1 swT Application

)

| E Main| 0 A(_guments: P8 Environment

Name: | simple

= g 5, Source [Z Common.

Debugger: |_gdh,fmi

F¥I 5top on startup at: [main | Advanced...

rDebugger Options
[ Main | shared Libraries

GDB debugger: [Dpu~gdb

| Browse... |

GDE command file: [.gdbinic

{Warning: Some commands in this file may interfere with the startup operation of the
debugger, for example "run*.)

GDB command set: | Standard (Cell BE) | v |

Protocol: mi [~]

[ Verbose console mode

| Browse... |

;___l [ close |

Figure 2. Correctly configured Debugger tab

Running Cell/B.E. applications

To run applications locally on a Cell/B.E. system, you can use either the C/C++
Local Application or the C/C++ Cell Target Application launch configuration.

The C/C++ Cell Target Application launcher was initially designed to allow for
the running/debugging of applications on a Cell/B.E. simulator or system, while
the development of that application was done on a computer without a Cell/B.E.
processor. However, you can use this same launcherto deploy an application
locally if you are running IDE on a system with a Cell/B.E. processor. In order to
accomplish this, you need to create a Cell Box environment (in the Cell
Environments view) with the configuration option Localhost selected (instead of
Remote host being selected). After you have clicked the green arrow to start the
localhost Cell Box, it can then be used as the target environment in the C/C++ Cell

Target Application launcher.

Chapter 6. Running IDE on Cell/B.E. systems
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Chapter 7. Running IDE on Power-PC systems

IDE can be run on a Power-PC (PPC) system.

The following topics are worth discussing if you plan to use this platform to run
the IDE:

* ["Managing builder paths for a PPC system”
ging p

This section discusses any issues that may come up when running the Cell IDE on
a Power-PC (PPC) system.

Managing builder paths for a PPC system

The SDK’s GNU and XL tool paths are at different locations on a PPC-based
system than on systems with Intel® processors. IDE’s default paths reflect the
default Cell/B.E. SDK tool paths of a Intel-based computer, so these paths must be
corrected if you wish to run IDE on PPC. This can be done as follows:

1. After|installing IDE} open Eclipse preferences. To do this, click Window »

Preferences.

2. Open the GNU Tools Managed Build Paths preference page: Cell » Managed
Builder Paths + GNU Tools Managed Build Paths.

3. Click Find it! to automatically find the GNU tools location, or click Browse to
manually select the location

4. Do the same for the XL Tools Managed Build Paths preference page

© Copyright IBM Corp. 2006, 2008 21
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Chapter 8. Using the CDT XLC error parser

This topic describes how to use the CDT XLC error parser with IDE.

The IDE is integrated with the Cell/B.E. GNU compilers and also with the Cell BE
XL compilers. The error messages printed by these compilers are parsed by the
appropriate error message parser in order to identify the error information and
display it correctly in the graphical user interface. This makes it easier for you to
solve problems that the compilers encountered with your source code.

The GNU C Compiler error message parser comes integrated with CDT. Previous
versions of the CDT did not support XL C/C++ compiler error messages and for
this reason IDE provides its own XLC error parser. However, from version 3.1.2
onwards CDT provides an XL C/C++ error parser, which you can install from the
CDT update site. If you prefer to use this XL C/C++ error parser instead of the
one provided by IDE, you need to follow the following instructions to the install
CDT XLC error parser as it is not installed by default when CDT is installed:

1. Install Java, Eclipse and CDT as described in steps 1 through 4 of the |IBM SD
[for Multicore Acceleration IDE Installation Instructions}

Note: The CDT XLC Error Parser is available from CDT version 3.1.2
onwards.

2. Start Eclipse. Make sure you start Eclipse with a user that has write permission
to the Eclipse installation directory.

From the menu, select Help » Software Updates » Find and Install...
Select Search for new feature to install, then press Next.
Click New Remote Site....

Enter a name in the Name field that identifies the update site, for example,
CDT Update Site.

7. Enter the following into the URL field
http://download.eclipse.org/tools/cdt/releases/callisto

o o~ W

8. Click OK. The recently created entry appears selected in the Sites to include in
search field.

9. Click Finish and follow the on-screen instructions.

After you have completed the above steps, a CDT XLC Error Parser entry appears
in the Error Parser tab. You can access this tab through any of the following:

* Select Window » Preferences... + C/C++ » Make »* New Make Projects

¢ From the C/C++ Build dialog page of a Managed Make C/C++ project
Properties

* From the C/C++ Make Project dialog page of a Standard Make C/C++ project
Properties

* From the final dialog of the project creation wizard for Managed Make C/C++
and Standard Make C/C++ projects.

From this Error Parser tab, you can deselect the IDE XLC Error Parser and select
the CDT XLC Error Parser.

© Copyright IBM Corp. 2006, 2008 23
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Chapter 9. Configuring public key-based authentication using

OpenSSH

The following topics describe how to configure your client and server (as well as
how to configure the IDE'’s environments) to use the public key authentication
method.

IDE establishes connections to remote Cell/B.E. environments using Secure Shell
(SSH). Two SSH authentication methods are supported:

e Password-based
* DPublic key-based

Step 1. Verify the software

First, confirm that OpenSSH is the SSH software installed on the client system.
Public key generation can be different for different implementations of SSH. Use
the ssh-V command to check the version of your SSH software as follows:

> §$ ssh -V
OpenSSH_4.3p2, OpenSSL 0.9.8b 04 May 2006

Step 2. Generate a key pair

You must generate a RSA public/private key pair on the client system. The public
key is copied to the remote server that is being connected to, the private key
remains on the client system in a secure location. Use the ssh-keygen command to
generate the key pair as follows:

client$ mkdir ~/.ssh

client$ chmod 700 ~/.ssh

client$ ssh-keygen -q -f ~/.ssh/id_rsa -t rsa

Enter passphrase (empty for no passphrase):

Enter same passphrase again:

Step 3. Distribute the key

Next, copy the public key ~/.ssh/id_rsa.pub to the remote server. After the public
key has been copied, you need to append the key’s contents to the file
~/.ssh/authorized_keys:

client$ scp ~/.ssh/id_rsa.pub user@server.example.com:
client$ ssh user@server.example.com

server$ mkdir ~/.ssh

server$ chmod 700 ~/.ssh

server$ cat ~/id_rsa.pub >> ~/.ssh/authorized_keys
server$ chmod 600 ~/.ssh/authorized_keys

server$ rm ~/id_rsa.pub

Step 4. Confirm the functionality

Attempt to connect to the server to confirm that the public key authentication
method is working. If you are using the public key authentication method, you are
asked for the passphrase when you connect:

client$ ssh -o PreferredAuthentications=publickey

user@server.example.edu
Enter passphrase for key '/home/user/.ssh/id_rsa':
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Step 5. Configure the Cell/B.E. environment
Finally, you need to configure the Cell/B.E. environment inside the IDE.

Note: Public key authentication can be used on any of the Cell/B.E. target
environment types except for the Local Cell Simulator type.

The following steps explain how to configure your Cell/B.E. Environment:
1. In Eclipse, open the Cell Environments view.

2. Open the cell environment’s configuration window by either creating a new
environment (right click environment type and select Create) or by editing an
existing environment (right click the existing environment and select Edit).

3. Select the option Public key based authentication.

4. Press the Browse button next to the field File with private key, and select the
private key file ~/.ssh/id_rsa.

5. Enter the passphrase that you entered when you created the public/private key
pair.

6. Click Finish and use the green start arrow to start the environment.
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Chapter 10. Troubleshooting and work-arounds

This topic describes solutions to problems you can encounter when you use IDE.

The following are known issues with IDE:
+ [“Using the Java API with the simulator”]
* |“Reconnecting to the GDB server”

* |“Ensuring that the remote launch directory is writable for all users”|

+ “Configuring the localhost” on page 28|

* [“Specifying MAC addresses for the local Cell/B.E. simulator” on page 28|

Using the Java API with the simulator

There is a known bug with the Cell/B.E. simulator’s capacity to use the Java API
along with the simulator GUI window. To enable the use of the Java API with the
simulator, you must set the option USE_JAVA_API to true:

USE_JAVA_API=true

This parameter can be found in the file parameters.properties, which is located at:
eclipse/plugins/com.ibm.celldt.simulator/com/ibm/celldt/simulator/conf

If the USE_JAVA_API option is set to true, the simulator GUI window cannot be
used.

Reconnecting to the GDB server

If you are debugging a Cell/B.E. application remotely using gdbserver and the
connection to the gdbserver is broken, IDE tries to reconnect automatically.
However, this is not successful even though the gdbserver is still running on the
target system.

If you stop this debug session and try to start a new one, IDE issues an error
because the gdbserver is still occupying the previous configuation port on the
target system and IDE is not able to launch another instance of gdbserver in the
same port unless the debug launcher configuration is modified.

The workaround for this is to kill the gdbserver application on the target system
before you launch another debug session again.

Ensuring that the remote launch directory is writable for all
users

The Cell/B.E. Target Application launcher automatically creates a remote directory
for launching the application. By default, this directory is given by following
macros:

${system workspace}/${user _workspace}/${project name}/${timestamp}

If you are sharing the remote (Cell/B.E.) system, make sure that all users can write
to the directory provided by ${system_workspace}.
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The first user that connects to the machine creates ${system workspace},
subsequent users create their directories inside ${system_workspace}. However, if
${system_workspace} was not created with full write privileges, then the
subsequent users will not be able to launch.

Configuring the localhost

When IDE uses the Cell/B.E. Target Application launcher and Local Cell/B.E.
Simulator, it calls Inet4Address.getLocalHost() several times. In some cases, this
method can fail if your system is not configured correctly. This failure can result in
IDE refusing to create new simulator environments or cause failures or both with
the Cell/B.E. Target Application launcher.

If you encounter this problem, check the /etc/hosts file and ensure that the
following line is present:

127.0.0.1 Tocalhost mymachine

where mymachine is the name of the system as given by the environment variable
$HOSTNAME.

Specifying MAC addresses for the local Cell/B.E. simulator

The local simulator configuration window allows you to choose your own MAC
address. If you decide to specify your own MAC address, the following rules
apply:
* The first number of the address MUST NOT be odd. It MUST be even. It should
be n*4+2 (02, 06, 10, ....)
— If the first number is odd, then SSH will not connect, even if simulator pings
successfully
— If the first digit is not n*4+2, then it does not conform to RFC
* It is recommended that the second and third numbers are 00

¢ The recommended MAC addresses are: 02-00-00-00-00-00, 02-00-00-00-00-01,
02-00-00-00-00-02, 02-00-00-00-00-03
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Part 3. IDE tutorial
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Chapter 11. IDE tutorial

This introductory tutorial explores IDE and provides click-by-click lessons on how
to use many of the main features of the IDE.

Purpose of this tutorial

In this tutorial you will learn how to:

* Create, build, and run PPU/SPU managed make projects
* Use the local Cell/B.E. simulator environment

* Use the performance analysis tools (static and dynamic)

* Configure and use the C/C++ Cell Target Application launcher to run and
debug your Cell/B.E. applications

e Use the ALF IDE wizard by means of an example usage scenario
* Use the IDE PDT to generate trace profiles

Preparation

Before you start with the tutorial you must prepare your system. You must have
IDE installed and running on the computer you want to use for the tutorial. For
information about how to install IDE, refer to [Chapter 3, “Installing IDE,” on page|

Learning time

You should allow two and a half hours to complete the tutorial.
Conventions

The following conventions are used in the task descriptions:
e Select File » New means "Select item 'New’ from the "File” menu.”
¢ (Click OK means "click the OK button”.

Table of contents

Click one of the following sections to jump to a particular section of the tutorial, or
to start at the beginning.

You can return to the table of contents at any time by clicking the "Parent topic”
link in the tutorial.

1. [“SPU project - create SPU project” on page 35|

[“PPU project - create the PPU project” on page 46|

[Cell/B.E. simulator - create the local Cell/B.E. simulator” on page 63|

[“Create an application launch configuration” on page 68

[‘Debug the application” on page 76|

[Dynamic/static performance analysis|

[“Simulator console - toggle the simulator console view” on page 85|
[Accelerated Library Framework API Wizard]

[“View the Eclipse preferences window” on page 118|
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10. [“View the IDE environment preferences” on page 119
11. ["IDE PDT plugin” on page 104|
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Getting started - open Eclipse

With CDT and IDE installed into your eclipse directory, open Eclipse and switch to
the C/C++ perspective. To do this click Window » Open Perspective » Other...

¥ Java - Echipae SOK:
File Edit Source Refactor Mavigate Search Project Bun [\ 01 Help .
B 0-Q &t @ G- |® 7 5 .l‘ie"_‘fWi_'?df:M = @

Iz Packa = % Hierar 2 FRETERECPVE  Debug =0 g Outline !"3 =0
S-S - Show View >_:&‘ Java ) '::;‘i’!ﬁ:j:,e is not
C ize Perspective.. ¥ Java g
Save Perspective As... |lan |
Beset Perspective
Close Perspective
Close All Perspectives
| Navigation >|
E Working Sets 3
.__El'e[arences,.,
[ Problems 5 & Javadoc Declaration B Y70
0 errors, 0 warnings, 0 infos )
Description Resourc Path Location
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Getting started - select C/C++ Perspective

Select C/C++, then click OK.

2 Java - Eclipse SDK I=x]
File Edit Source Refactor Navigate Search Project Run Window Help
[¢-0-a |see &7 = [@ava
“o|soutlines =8

cka %" T Hierar (=0

B~

CIC++

% CVS Repository Exploring
% Debug

&' java (default)

& java Browsing

%’ Java Type Hierarchy

% Plug-in Development

& Resource
|&8% Team Synchronizing

0K i Cancel

[ Problems & @ ja\radoc-= . Declaration
0 errors, 0 warnings, 0 infos
Description Resourc Path Location
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SPU project - create SPU project

Objectives: After you have completed this part of the tutorial you will know how
to:

* Create and configure an SPU project

* Add the directory that contains the profile.h header file to the list of the
compiler’s include paths so that you can use the dynamic performance analysis
tool

* Create a C source file
¢ Automatically build the project

Create a new C project. Click File » New » Project.

.|| Edit Refactor Navigate Search Project Run Window Help

B |ECiCHs

| oen File,.. - .
l =0 |[EQutline 22~ # MakeTa =B
W An cutline is not available.
tri45 | &5 Source Folder
i Folder
;| i¢ Source File
x Header File
| % File
@ Class
Aefr - Example...
Conyert Line Delimiters To ¥ 4 Qther...
¢ t |
Switch Workspace >
wlmport... |
w3 Expart...
roperti 1 l
Exit. y
= Problems = #iTasks © Console 7 Properties & Remote Environments il =]
0 errors, 0 warnings, 0 infos N - -
Description Resourc  Path Location
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SPU project - select the C Project Wizard

The New Project wizard is displayed.
1. Expand the section C.
2. Select C Project.

I 5,0.6]

e

[ e T

File Edit Refactor Mavigate Search Project Bun Window Help
B 0-Q- @& g

r &y 64 (- @

= Project Explarer & a8 'E"'—-mE_' . =0|Eoutline = @ MakeTa = 0]
: L L /An outline is nat available.

Select a wizard

Create a new C project =

Wizards:
|type filter text

1 Java Project
# Java Project from Existing Ant Buildfile

& Plug-in Project
b = General

¥ = ALF for Cell
= &=C

Inomcas

i

2 —al

& <

10 errors, 0 warnings, 0 infos. . o
Description Resourc Path Location

3. Click Next.
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SPU project - enter the project name and define the project type

For Project name, enter SPU. You can select the appropriate Project Type (Cell PPU
Executable, Cell SPU Static Library, and so on) for the project you are creating.
When you select a project type, you see the default Configurations available for
that project type. Later in the tutorial you will learn how to create new build
configurations, as well as how to modify the existing built-in configurations’
settings.

1. For Project Type, select Cell SPU Executable.
2. Click Finish.

+ . ; e
File Edit Refactor Mavigate Search C Project —
- W 85 - g~ Create C project of selected type :

¥ = \_@_gc-u; %
[ Project Explorer n i T O =Outline = ®MakeTa =0
Project name: [_SF'U | An outline is not available.

¥ Use default location

Project types: Teolchain:

b o Executable SPU GNU Debiug Tool Chain
& Shared Library SPU GNU Release Teel Chain

= Static Library

© Executable (XL C/C4+)

© Static Library(XL C/C++)

© Shared Library (XL C/C++)

© Cell PPU Executable

© Cell PPU Static Library

© Cell PPU Shared Library

© Cell SPU Static Library
bz Makefile project

# Show project types and toolchains only if they are supported on the platform

& < Back Next > L : | Cancel
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SPU project - configure SPU Project

In the C/C++ Projects view:
1. Right click the SPU project.
2. Select Properties.

“E/Ces - Eclipse SDK

File Edit Refacter Mavigate Search Project Run Window Help

W @ 2@ K-8 B0 | & o [@eices -
. Project Explorer &2 g% v=0 =0 EOutline = © MakeTa = 5]
. New r \An outline is not available.

Open in New Window
1 Copy CErl4C
# Delete Delete
Rename F2
& [mport...
w3 Export...
Clean Project
* Refresh F5

Cloge Project
(| ted Projects

Build Configurations >

Make targets »

Index >

Convert To...

Bun As » |
Debug As o NS W Ao e ok [ kTR E RORITN * * <o)
Profile As »| warnings, 0 infos.

Team >0 Resourc) Path Location

Compare With »

Restore from Local History...

PDE Tools 5

g oete  Auter
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SPU project - add directory the SPU compiler include paths list

You need to add the directory that contains the profile.h header file to the list of
the compiler’s include paths so that you can use the dynamic performance analysis

tool.

1. Click C/C++ Build in the left pane.

2. Under SPU GNU C Compiler with Debug Options, select Directories.

3. In the Include Paths pane on the right, click the Add button.

File Edit
. | (CTOIEEED
Resource
Builders
= C/C++ Build

Discavery optic
Environment

Tool chain edito
Variables
XL CiC++ Com)
¥ C/C++ General
Praject Reference
Refactoring Histe
Run/Debug Settin

Settings

Configuration: | spu-gnu-debug

< | |Manage cenfigurations

joices -

akeTa =0

Tool settings |+ Build steps |~ Build artifact i Binary parsers  Error parsers

= SPU GNU Assembler
& General
= ®SPUGNU C Linker
2 General
(& Libraries
12 Miscellaneous
& Shared Library Settings
(@ Profile & Trace
(= 0verlay
= & SPU GNU C Compiler with Debug Options
& Preprocessor
i Symbols

& Optimization
12 Debugging
#Warnings

@ Miscellaneous

& Profile & Trace

i Include paths I‘-i}

ihdd

E;Restnre néfaﬁlts_ i 3pél2_

ok | cancel

ailable.

# 7=
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SPU project - add the directory path

1. Enter /opt/ibm/systemsim-cell/include/callthru/spu
2. Click OK twice to return to the C/C++ Perspective.

. Sl
File Edit | = : Froparties For SPU
- type filter text| Settings 2
mﬁe Configuration: | spu-gnu-debug = ||Manage configurations| akea |~
= CIC++ Build ailable.
Discovery optic | ool settings | ~Build steps | Build artifact iBinary parsers o Error parsers
Environment — iz T =
= & SPU GNU Assembler Include paths (-1 a
Tool chain edito SGeneral )
Variables Addidiree

XL C/C++ Com

¥ CfC++ General ] . . 3
Project Reference { |/opt/ibmisystemsim-cellfincludescalithrujspu
Refactoring Histo
Run/Debug Settin

[ ok || cancel || workspace. |Filesystem.. |

& Symbals
# Optimization
i Debugging
@ Warnings
(2 Miscellaneous
(B Profile & Trace

" |Restore Defaults | |

|

@ Lok ]|
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SPU project - create a new source file

Create a C source file. Click File » New » Source File.

Open File,..

CiCs#+ - Eclipse’sDK’

i Header File

Mowe 13 File
Rename... F2|@ Class
Refresh
Conyert Line Delimiters To
Print.. F
Switch Workspace »
i Import...
w3 Expart..
Properties Alt+Enter
Exit
e -
lL Prbﬁlems__@;ﬁéksi-s Console - & Pmpert'izs_ftb .ﬁemdte.ﬁnvi-r;nnmen.ts-f
\C-Build [SPU]
*s++ Build of configuration spu-gnu-debug for project SPU *+**»
Nothing to build for project SPU
| & 5 SPU

=0[Eoutline s @ MakeTa =D
\An outline is not available.
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SPU project - enter the new source file name

1. In Source File, enter spu.c.
2. Click Finish.

LB CCEY - Eclipss SDK. DEE
File Edit Refactor Mavigate Search Project Bun Window Help
ri- SRR S S-S S TS R O .g »
@ Project Explorer 2 =0 =0|=outlinex  © MakeTa =0
- e | S |An outline is not available,

EEr——
| )

Create a new source file. =

Source Folder: [5PU || Browse...

Source File:  |spu.c

**++ Build of configuration spu-gnu-debug for project SPU *++»

Nothing to build for project SPU

5 SPU
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SPU project - edit the source file

A new editor is displayed so you can enter your source code. Copy and paste the

following source code into your editor (you will uncomment the commented lines
later):

#include <stdio.h>
#include <profile.h>
int main(unsigned long long id)
{
//prof_clear();
//prof_start();
printf("Hello Cell (0x%11x)\n", id);
//prof_stop();

return 0;

PU/Eale ~Edipse 50K

File Edit Refacter Navigate Search Project Run Window Heip

fae R - TR - SR TS B S T R S B [EeCH "
. Project Explorer & =0 ESEII.:-I!.;E § =0)&Outline 5 & MakeTa | =0
= o = | #include <stdio.h> s v
T b #include <profile.h> = AR
= S SPU u stdio.h
b & Binaries int main{unsigned long long id) u profile.h
{ g
b & Includes Pipretsclanrli = mainf{unsigned long long)
b e spu-gnu-debug //prof_start();
printf("Hello Cell (@x%llx)\n", id};

//prof_stop(}:

return 0;

i Problems a'l'asks@ Consale & o l"ropel'lié 3 Remote Environments| & G o r5- =0
\C-Build [SPU] 1
Building target: SPU =

Invoking: SPU GNU € Linker
spu-gcc -Wl,-N -0"SPU" ./spu.o
Finished building target: SPU

Writable Smart Insert  13:1

Chapter 11. IDE tutorial 43



SPU project - automatically build the project

Save the source file (Control + S). The project is automatically built.

The build output is displayed in the Console view, and new resources, such as
binaries and includes, are displayed in the C/C++ Projects view.

€/E++- SPUdplic - Eclipse SO

File Edit Refactor Navigate Search Project Bun Window Help
£3- @ | @8 E G | R B (R0 [ B

\-_-Project'Explorera's =i éspu,c'é' ) =0/ & Outline & |
= % = || #include =stdic.h= i s
o #include <profile.h> : L

= S5PU # stdio.h

b ¢ Binaries int main(unsigned long long id) u profileh

it i
b = Includes tiprof_clear(); = mainfunsigned long long)
b e spu-gnu-debug Jiprof_start();

¥
printf("Helle Cell (oxsllx}\n*, id);
/iprof_stop(};

return 0;

& Problems 2 Tasks @ Console i T Properties & Remate Environments B |l ri- =0
|C-Build [SPU]

#*** Build of configuration spu-gnu-debug for project SpU *+++

make all

Building file: ../spu.c

Invoking: SPU GNU € Compiler with Debug Options

spu-gcc -Ifopt/ibm/systemsim-cell/include/callthru/spu -08 -g3 -Wall -c -fmessage-length=0 -Winline -Wextra -
fno-inline -mtune=cell -mfloat=fast -mdouble=fast -Wno-main -march=cell -mea3Z .MMD -MF .MF"spu.d" -
MT"spu.d* -o"spu.o® *../spu.c”

Finished building: ../spu.c

Building target: SPU

Invoking: SPU GNU € Linker
spu-gee -WL,-N -0"SPU" . /spu.o
Finished building target: SPU

Writable Smart Insert  12:2
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PPU project - create a PPU executable project

Objectives: After you have completed this part of the tutorial you will know how
to:

* Create a PPU project
* Configure the PPU project
* Add the SPU executable as an embed SPU input

Now create a PPU executable project that uses the Embed SPU tool in your SPU
project.

Click File » New » C Project.

it Refactor Navigate Search Pi

Open File,.. =] @Ci|
Close | ‘fﬂ & Outline 2 . & Make Ta |=B2
Close All Shift+Ctrl+W = Convert to a C/C++ Make Project ' Al o
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!Building target: SPU
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| Finished building target: spu
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PPU project - create the PPU project

Create the PPU project:

1. For Project name, enter PPU.

2. For Project Type, select Cell PPU Executable
3. Click Next.

=
_Ei!E Edit Rgfa(,!,plf uavig_atﬁ Sea!
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PPU project - reference the SPU project - step 1

The project SPU that you created earlier is listed. Because you will embed the SPU
project’s executable into the PPU project, you need to reference it.

Click Advanced settings.

. —————————8 1%

'
File Edit Refactor Navigate Searc

Select Configurations -—
i L & ‘ Select platforms and configurations you wish to deploy on 5 - 8 @Uﬁ"‘ﬂ -
S an =0 & Outline 2" ®MakeTa =0
s v Project t‘ypa: Cell PPU Exen:llable . a Ao e ™
b SPPU 'r{:oorli;ichamtsl: PPU GNU 32 bit Debug Tool Chain 2 Zdioh
i w profieh
¥ & ppu-gnu32-debug [ Select all | = mainfunsigned long leng)
| Deselectall |
)
H m— 3
& o @ rsv =0
L
n T ——
E @Wnoed.setxir_rgs..]
Use "Advanced settings® button to edit project's properties. -length=0 -Winline -Wextra -
WD -HP -MFspu.d* -
K Additional configurations can be added after project creation.
f Use "Manage configurations" buttons either on toolbar or on property pages.
E
) | <Back | MNext> || Finish Cancel
iy 5 SPU

Chapter 11. IDE tutorial 47



PPU project - reference the SPU project - step 2

1. Go to the Project References category.

48

2. Click OK.
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PPU project - finish creating the PPU project

Click Finish to create the PPU project.
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PPU project - configure the PPU project

50

In the C/C++ Projects view:
1. Right click the PPU project.
2. Select Properties.
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Convert To...
Bun As »
Debug As »
Profile As 5
3
H

Team
Compare With

Restare from Local History...
PDE Togls
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PPU project - select the C/C++ build options

1. In the left pane, select C/C++ Build.

In the Configuration group at the top, you can change the current
configuration (for example. ppu-gnu32-debug, ppu-x132-debug, and so on) or
create your own. In the Builder settings tab, you can manipulate builder and
makefile configurations.

2. Click Manage configurations.

e
file Edit Refac®

C/C++ Build

Resource = f
Configuration: | ppu

Builders o Al
+ CfC++ Build o ~
b C/C++ General = Builder settings | = Behaviour
b w5PU Praject Refarances Sl IESCIANIONE)
Refactoring History U_ e R — — leng)
Run/Debug Settings Builder type External builder v
+ Use default build command
Build command: [ake Variable
Makefile generation
¥ Generate Makefiles automatically + Expand Env. Variable Refs in Makefiles B'E-';
Build location
Build directory [S{workspate_loc /PPUIApU-GNI3Z Gablt

Restore Defaults | Apply |

@ P 0K | i’ Cancel el

15 PPU
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PPU project - view the Manage Configurations window

52

In this window you can rename, remove, or create new build configurations.

Click OK to continue.

S v Gl clinsa i e ELES]
File Edit Refa ll_ ___________________ Properties for PPU [
s 4 | (typefilter text | C/C++ Build = kl =
— —— Resource ) = _ — k=
& Project Explod Bullders Configuration: | ppu-gnu32-debug b ||Manage cunhgurahr.msj ﬂ_
- C/C++ Bulld p
b CfC++ General = Builder settings = Behaviour
b =5 SPY Projsct Refernces : [t L |
¥ : Builder
Refactoring History . long)
Run/Debug Settings . l
Configuration Description  Status | —] T
ppu-gnu3z-debug PActive ==
Makefile g¢ ppu-gnu3-release =1
3
& Gener, Makefiles ’:;-
Build locat| - = - = |
Build dired | Set Active New. || Remove || Rename |
| Restore Defaults | Apply
[ — | el S| T
1 @ oK | i Cancel =
& PPU
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PPU project - add the libspe2 library to the library linker list - step 1

You use libspe2 in your PPU source code, so you need to add the library "spe2” to
the linker’s list of libraries.

1. In the Tool Settings tab, select the Libraries option, which is under the PPU
GNU 32 bit C Linker category.

2. Click the Add button in the Libraries pane on the right.

[typefilter text |  Settings 7
Resource = -
oF Builders Configuration: | ppu-gnu32-debug 2| [Manage configurations| || =&
~ C/C+4 Build s =
sl iscovery options §Tool settings | Build steps | Build artifact ) Binary parsers o Error parsers|
b S SPU Environment - 3
= & PPU GNU 32 bit Assembler Libraries (-1} alu lang)
Tael chain editor & General | Add
Variables = ® PPU GNU 32 bit Embed SPU
& Inputs

XL CfC++ Compil

b CiC++ General
Project References
Refactoring History
Run/Debug Settings

2 Architecture
= % PPU GNU 32 bit C Linker = S
22 General Library search path (-L) L]
ies i<

L)
L]

 Miscellaneous

@ Shared Library Settings
2 Profile & Trace
= Architecture

= % PPU GNU 32 bit C Compiler with Debug Options |||  Math library {-Im)

& Preprocessor 1 Pthread library (-Ipthread)

ESymbols (1 libspe2 (-Ispe2)

= Directories E
& Optimization

i Debuggi

Restore Defaults | Beply |

C— 7

@ | ok || cancel

5 PPU
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PPU project - add the libspe2 library to the library linker list - step 2

54

Enter spe2, then click OK.

& B SRR OER
m_! Properties for PPU X1 ’
oAt = .
£ g | [ypefltertex | |(Settigs e T
Resource n
Builders Configuration: | ppu-gnu32-debug < || Manage configurations| | =5
= CiC++ Build b =
Discovery options
Environment -~
5 ong)
Tool chain editor
Variables
XL C/C++ Compil Libraries (-1}
b C/C++ General
Project References ISp.ez ] I .
Refactoring History & LH';!
Run/Debug Settings
e[ cancel |
= ATCHTECtre &= -
= % PPU GNU 32 bit C Compiler with Debug Options ||| [ Math library {-Im)
i Preprocessor [ Pthread library (-pthread)
& Symbols [ libspe2 (-Ispe2}
i Directories |
& Optimization
i Debugging
PP
q 5 |Restore Defaults | Apply |
(I ) 1 ]
@ [ ok | [ cancel |

[ weey
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PPU project - add the SPU executable as an embed SPU input - step 1

In order for the PPU project to embed the SPU project’s executable, you need to
add the SPU executable as an embed SPU input.

1. In PPU GNU 32 bit Embed SPU, select the Inputs option.
2. Click the Add button in the Embed SPU Inputs pane.

TR
File Edit

B [type filter text

- Resource o =
1= Builders | Configuration: | ppu-gnu32.debug ¢ | Manage configurations| & =0
= CIC4++ Build g
Discovery options 7ol settings |+ Build steps  Build artifact - Binary parsers o Error parsers.
b ESPU Environment F ; 3 -
= % PPU GNU 32 bit Assembler 1| | Embed SPU Inputs ol | |biongd
Tool chain editor | @ General add]
apiablis = ® PPU GNU 32 bit Embed SPU =
XL C/C++ Compil
¥ C/C++ General & Architecture
Project References | 7 ¥ PPUGNU 32 bit C Linker
Refactoring History @ General l_::
Aun/Debug Settings & Libraries -

@ Miscellaneous
@shared Library Settings
3 Profile & Trace
@ Architecture
= @ PPU GNU 32 bit C Compiler with Debug Options
& Preprocessor
= Symbols
@ Directories
2 Optimization
& Debuggi

5 PPU
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PPU project - add the SPU executable as an embed SPU input - step 2

Click the Workspace button.

Edit Refa(>
o, | [typefilter text
Resource
Builders
= C/C++ Build

Environment
Tool chain editor
Variables
XL C/C++ Compil
» C/C++ General
Project References
Refactoring History
Run/Debug Settings

E

Discovery options | gTool settings | B

Properties for PPU

Settings

| Configuration: | ppu-gnu32-debug

< || Manage configurations |

uild steps  Build artifact i Binary parsers o Error parsers,
|= ® PPU GNU 32 bit Assembler d & :
& General

] _?:Jesystem... |

Architecture
I+ ® PPU GNU 32 bit € Compiler with Debug Options

& Preprocessor

@ Symbols

@ Directories

& Optimization

& Debugging

[Restore Defaults | Apply

[ e ][

Cancel |

g long)|
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PPU project - add the SPU executable as an embed SPU input - step 3

1. Select SPU » spu-gnu-debug » SPU.
2. Click OK twice to return to the Properties for PPU window.

2 Citad o Lis b
File Edit Refa L) Properties for PPU
- | (cype filter test fattinas il
- - et Resource | =g
BProject Expid e Configu B
= CIC++ Build Select a file from workspace: L
BEIEUMN oiscovery option: graoise| » wipPU
b ESPU Environment r 4 v S SPU L = -
Settings Ti® ';Pc “ & spu-gnu-debug 2 g long)|
Tool chain editor b ;
: o €a R gma.loehlz ==
Veriables 5 & objects.mk =
XL CfC++ Compil Fil & sources.mk
FGIO - Gengal ' mm
Project References |~ ! 0l o spud — =
Refactoring Hlslfcry i spu.o . =n
Run/Debug Settings »subdirmk
1 .cproject
[ project E
oA [& spu.c
~ ® PP
BH
&g
ot o el | conel |
&d B -
& Debugging |
E = | Restore Defaults | Apply |
(—— 5] R R =
| @& 0K | Cancel |
& PPIJ
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PPU project - configure additional settings

You can configure additional settings via the other tabs (for example, Build steps,
Binary parsers, and so on), and categories (such as Project References).

Take a minute to explore these other tabs and categories, then click OK.

£ B | Settings
PR Resource
& Project Expl e Configuration: | ppu-gnu32-debug 2 || Manage g il 2
| v C/C++ Build £°
[ =peu | Discovery options | ool settings » Build steps | Build artifact iiBinary parsers @ Error parsers
b SSPU Envirenment : — - =
= % PPU GNU 32 bit Assembler Embed SPU Inputs aa 8 g lang)
Tool chain editor & General *${workspace_loc:/SPL/spu-gnu-debug/SPUL"
variables = ® PPU GNU 32 bit Embed SPU
XL CIC++ Compil
b C/C++ General i Architecture I
Project References | |~ PPUGNU 32 bit C Linker .
Refactoring History @ Saneral P = ;;
Run/Debug Settings & Ll!lrarles g
= Miscellaneous =
2 Shared Library Settings
2 Profile & Trace
@ Architecture
~ ® PPU GNU 32 bit C Compiler with Debug Options
(& Preprocessar
& Symbols
(& Directories
# Optimization
& Debugging I
C——T Restore Defaults | apply |
L] [ oK || Ccancel o}
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PPU project - create another new source file

1. Right click the PPU project.
2. Select New » Source File.

file Edit Refactor Navigate Search Project Bun Window Help
= g ar g e (R O B0V A [ w = |-
| Project Explnrsr.};i L =o @ spu.c u 3 =0/ outline . ® Make Ta |
= clude <stdio.h> - | Aw e T
| u stdio.h

u profile.h |
© Copy Ctrl+C s mainfunsigned long long)

b @sPU

s Import... C++ Project
I Expart... + Example...
Clean Project |1 Qther..
£ Refresh F3
Cloge Project

. & Remote Envimnmenisi

Build Configurations >
Make targets

Index

Convert To...

Bun As

Debug As

Erofile As

Team

Compare With

Restore from Local History...
PDE Togls >

Properties Alt+Enter

v

v e W ow W
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PPU project - enter the name for the new source file

In the Source File field, enter ppu.c, then click Finish.

s SiCE+~SAU/Sp,c A ECHPSS SRS
File Edit Refactor Navigate Search Project fun Window Help

B @2 e- %9 |[$-0-9 @@ 4 o [Reice
ject Explorer & =o@spucs =0 goutiine % & MakeTa = 1|
= % = #nclude <stdio.h> Lo e ~
: - o
b S SPU N u profile.h

Create a new source file. < | = mainfunsigned long long)

Source Folder: {Ffu
Source file:  [ppu.c

Cfmsh ]| concel |

= PPU
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PPU project - edit the source code file

Copy and paste the following source code into your editor, then save it (Ctrl+S):

#include <stdlib.h>
#include <stdio.h>
#include <errno.h>
#include <libspe2.h>
#include <pthread.h>

extern spe_program_handle_t SPU;
#define SPU_THREADS 8

void *ppu_pthread function(void *arg) {
spe_context_ptr_t ctx;
unsigned int entry = SPE_DEFAULT_ENTRY;

ctx = *((spe_context_ptr_t *)arg);
if (spe_context_run(ctx, &entry, 0, NULL, NULL, NULL) < 0)
{
perror ("Failed running context");
exit (1);
}
pthread_exit(NULL);

int main()

{
int i,
spe_context_ptr_t ctxs[SPU_THREADS];
pthread_t threads[SPU_THREADS];

/* Create several SPE-threads to execute 'SPU'.*/
for(i=0; i<SPU_THREADS; i++)
{
/* Create context x/
if ((ctxs[i] = spe_context_create (0, NULL)) == NULL)
{

perror ("Failed creating context");
exit (1);
}

/* Load program into context =/

if (spe_program_load (ctxs[i], &SPU))
{

perror ("Failed loading program");
exit (1);
}
/* Create thread for each SPE context =/
if (pthread create (&threads[i], NULL,
&ppu_pthread_function, &ctxs[i]))
{
perror ("Failed creating thread");
exit (1);
}
}

/* Wait for SPU-thread to complete execution. =/
for (i=0; i<SPU_THREADS; i++)
{
if (pthread_join (threads[i], NULL)) {
perror("Failed pthread join");
exit (1);
1

/* Destroy context */
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if (spe_context_destroy (ctxs[i])

perror("Fail
exit (1);
}
}

0) {

|=
ed destroying context");

printf("\nThe program has successfully executed.\n");

return (0);

|15 Project Explorer B :

= @ PPU
b & Binaries
b sincludes
b & ppu-gnu3z-debug
b = spu_objs

;P =310

File Edit Refactor Navigate Search Project Run Window Help
R B R R T T B R
=0|[@spu.c |g1 vpm;«!_z 1
sl .7

| o B | e

=0 Outline 2 ®MakeTa |0
BR e

] £
} o stdlib.h
/* Wait for SPU-thread to complete execution. */ u stdio.h
for (i=0; i<SPU_THREADS; i++) { u errno.h
if (pthread_join (threads[i], NULL)) { B
| perror(“Failed pthread join"); M libspe2.h
| exit (1); u pthread.h
H ® SPU:spe_program_hand|
/* Destroy context +/ ) SR THREADS:
if Espe_fo:t?l:tadgst;oy ;clxs[:!} :!;m { = ppu_pthread function(ve
perror("Failed destroying context"); i)« i
| i exit (1); i it

i

printf("\nThe program has successfully executed.\n");

|
|
| return (8);

|;I2;.Prnblem .-@‘hsks;'-ﬁlcnnsnle-;vs" a Prnpeﬂies‘f& Remote Enviranments.
|C-Build [PPU]

| FANLSTES DULLOINY:
|Building target: PPU

Invoking: PPU GNU 32 bit € Linker
ppu-gee -m32 -0"PPUT . /ppu.o . /spu_obis/SPU.o
| Finished building target; PPU

C P SPU_DD) S/ 3R, spud

-1spe2

Writable Smart Insert 691
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Cell/B.E. simulator - create the local Cell/B.E. simulator

Objectives: After you have completed this part of the tutorial you will know how
to:

* Create an environment

* Configure and start the simulator

Now that the projects are created and properly configured, you can test your
program, but before you do this, you must create and start a Cell/B.E.
environment. IDE integrates IBM’s full-system simulator for the Cell/B.E.
processor into Eclipse, so that you are only a few clicks away from testing your
application on a Cell/B.E. environment, even if you do not have access to a
physical Cell/B.E. processor.

In the Remote Environments view at the bottom:
1. Right click Local Cell Simulator
2. Select Create.

0

File Edit Refactor Navigate Search Project Run Window Help

v W e F- @~ O~ Q| ™ L] ;JL@EEw "
i Project Explorer = =0|Espuc | [ ppuc:E =0 Eoutline= - @ MakeTa = 0O
o } A BARe T
= &PPU : u stdlib.h
b & Binaries /* Wait for SPU-thread to complete execution. */ u stdio.h
b & Includ for (i=0; i<SPU_THREADS; i++) { 3 o
S Rl e if (pthread_join (threads[i], NULL)) { ;E-;rrm h
b i ppu-gnu32-debug perror{“Failed pthread join"); B libspe2.
b = spu_objs exit {1); u pthread.h
3 ® SPU:spe_program_hand
b SPU /* Destroy context */ @ SPU_THREADS
ir {spe_:ogtf;{tadgsxmy (ctxs[i]) !=,0I { « ppu_pthread_function(ve
perror{"Failed destroying context®); ik
exit {1); gLl
¥
printf(*\nThe program has successfully executed.\n");
return (0);
= ; L
[z Problems < Tasks & Console = Properties % Remote Envi £ =o
Target Environment Status
Attached Cell Simulator
Generic Host
~ localCell Simulatppemygen |

Remote Cell Simul o
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Cell/B.E. simulator - configure the simulator

This is the Local Cell Simulator properties window, which you can use to

configure the simulator to meet any specific needs that you might have. You can
modify an existing Cell/B.E. environment’s configuration at any time (as long as
its not running) by right clicking the environment and selecting Edit.

1. Enter a name for this simulator (for example, Local Cell Simulator).
2. Click the Simulator tab.

-f.ile Edit Refactor Mavigate Sear

L Wi | - oas-

‘& Project Explorer 2

~ S PPU
b & Binaries
b & Includes
b @& ppu-gnu3z-debug
b i spu_objs

b S SPU
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= B

-

Local Cell Simulator
Properties for launch Local Cell Simulator

Target name: |Local Cell Simulator

Hardware|Simulator Connectivity Launch|
Hardware Configuration
Processor Type: :_‘.}i_!ig[e_ EE
Root File System
Storage is: | Nq'ri_-qersistenl 2]
fe|

Kernel: I.f_qptrihm(_systemsim-ceitfimages.fcellivmlinux

| Browse|
Root file system: | fopt/i ystemsime-c ges/cellfsysroat_disk .'Browsei
[ More options|
@ Finish | Cancel |
| EPronTeEms < 1a5Ks T S LONSoE T FTORETTES I TS T

Target Environment
Attached Cell Simulator
Generic Host

o [maeey -
=0/ Foutliner @ MakeTa |20
[ ARde "

u stdlib.h

u stdio.h

u errno.h

M libspez.h

u pthread.h

* SPU:spe_program_hand
# SPU_THREADS

= ppu_pthread_function(ve
= maini) ; int

-
Status

Local Cell Simulator
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Cell/B.E. simulator - configure the simulator options

In the Simulator tab, check the box labeled Show TCL console, then click Finish.

File Edit Refactor Navigate Seard

3= w | g el §- @

I Project Explorer 8

‘= B PPU
b & Binaries
b & Includes
b e ppu-gnu32-debug
b = spu_objs

P esSPU

==

Local Cell Simulator

Properties for launch Local Cell Simulator

=0/ % Outline - @ MakeTa | =0

el I .
Target name: [Local Cell Si | % HliEh 2l
{Hardware/ Simulator |Connectivity Launch, u stdioh
Simulator Options u errno.h
 Show simulater control window # Show Linux console 1 libspe2.h
 Show TCL consale u pthread.h
# Use default working directory ® SPU:spe_program_hand
Warking directory: [fopt cellirun/callflinux IE # SPU_THREADS
More options : zﬂ:;:;r::djunmmrm
2 [ Fnish_ || Cencel | |5 |
= —— B I — B
= PTODIEMS # Ta5KS & CONS0IE I ProPerTies & fe s CImommenTs =0
Target Envircnment Status

Attached Cell Simulator
Generic Host

Remote Cell Simulator
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Cell/B.E. simulator - start the simulator - step 1

1. Click the + next to Local Cell Simulator.
2. Select the new simulator environment.
3. Click the Start the Environment (green arrow) button.

C/E¥Y - PPUjppulc - Eclipse SDK
File Edit Refactor Navigate Search Project Run Window Help

C3 SR e S - EES | 0% | 7 | % E»

[ Project Explorer o =0 [Gspu.c !';a ppu.c s : °n | & Qutline P = Make Ta =a
an " } E =1 T
= PPU ¥ | u sediibh

b ¢ Binaries /* Wait for SPU-thread to complete execution, *f u stdioh

b & Includ for (1=0; 1<S5PU_THREADS; i++) { = h

fp S Esﬂd b if (pthread_join (threads[i], NULL}) { fLrnuzh

* & ppU-gracZ-debug perror{"Failed pthread join"); B libspe2,

b o spu_objs exit (1}; u pthread.h |
DT ' « SPU: spe_program_hand|
b EBSPU /* Destroy context */ # SPU_THREADS

if (spe_context_destroy (ctxs(i]} != @} { = ppu_pthread_functionfvo,
perror{“failed destroying context"); » main() : int
exit (1); d
}

printf{*\nThe program has successfully executed \n"};

return (8);

:I.L_Prohlemi -va'l'ask's E Cansole.-l:l Proper:iesi-&.henm,e__ Envirenments :

Target Environment - Start the Environment|

ALlaLiEy LEn SnnrE
Generic Host
— Lecal Cell Simulator

Local Cell Simutator
Remote Cell Simulator
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Cell/B.E. simulator - start the simulator - step 2

The simulator now begins to launch (this can take a few minutes).

C/C++ - PPU/ppu.c - Eclipse SDK

File Edit Refactor navig_ate Search Project Run Window Help

e i

. Project Explorer =

| SPPU
b i Binaries
b & Includes
b & ppu-gnud2-debug
b e spu_objs
I B ppu.c
b S5PU

& | W @@ |

i Problems £ Task

[#=0-a |& 2 | | ®
;r,asp_u.: |';§ppu.c§'.__

}
}

/* Wait for SPU-thread to complete execution, */
for (i=0; i<SPU_THREADS; i++) {

TUEERTE the Environment

@ Launch Local Cell Simulator

Creating the machine

Cancel

Run in Background | || petails >>

| -~ [ Properties b Remote Environments|
Linux console fer Local Cell Simulator

< [Beerr -

=0/ Eoutline 5 & MakeTa =8

s om0 EE E|

b i S
stdlib.h
stdio.h
errno.h
libspe2.h
pthread.h
SPU : spe_program_hand
SPU_THREADS
ppu_pthread_function(ve
mainf) : int

be B 2 @3- =0

| Start the Envirenment: (7%)

ac
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Create an application launch configuration

68

Objectives: After you have completed this part of the tutorial you will know how
to:

* Create and configure a C/C++ Cell Application launch configuration

Next, you need to create and configure a C/C++ Cell Application launch
configuration.

To do this, click Run » Open Debug Dialog.

r4- B | @i Boav | 'bj ik SRR

& Project Explorer B o ir =8 & Outline =

i : S | agle W €]
= SPPU } CISkip All B u stdlibh
b & Binaries Remoye Al Al |73 u stdioh
b & Includes Bun Ceri+Fll u errnch
b & ppu-gnu32-debug Debug F11 & libspe2.h
b i spu_objs ex  Run History u pthread.h |
| . &ppuc . RunAs ® 5PU: spe_program_hand
| b &55PU /+ 1@ Open Run Dialeg... # SPU_THREADS
if [ Debug History = ppu_pthread_function(ve
=°- Debug As » = main(} : int
JI - Open DebgDElog
} .C_l. External Tools N
printf(“\nThe program has successfully executed.\n");
return (B);
E ﬁu_ L —— )
i Problems & Tasks B Console i Properties  Remote Environments, B @ ot Bvre ™0
|Linux console for Local Cell Simulator |
[root@(none) tmp]# stty -echo [

[root@{none) tmp]# Configuration complete
[root@{none) tmp]#( INFO: Use this console to write Linux/Bash commands inside the simulator!)
( INFO: The simulator is PAUSED,)
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Application launcher configuration - create a new C/C++ Cell/B.E.
target application configuration

In the left pane:

1. Right click C/C++ Cell Target Application.

2. Select New.

_ GfC++ - PPU/ppu.c - Eclipse SDK

File Edit Refactor Navigate Search Project Run Window Help

o L

[ Project Explorer =2

= e PPU
b ¢ Binaries
b & Includes
b &= ppu-gnu32-debug
¥ =spu_objs

|k &ESPU

e @ e

ation:

and run

Create,

Configure launch settings from this dialog:

- Press the 'New' button to cre...iguration of the selected type.
Press the 'Duplicate’ button ._opy the selected configuration.
“Press the 'Delete’ button to ..ove the selected configuration.

] IC+ + Local Appl

@ Eclipse Application | ... |- Pressthe 'Filter' butten to configure filtering options.

5 Java Applet 1 - Edit or view an existing configuration by selecting it.

1 Java Application

Ju JUnit Configure launch perspective settings from the Perspectives
Ji JUnit Plug-in Test preference page.

4 0SGI Framework

SPU Timing (Std. Make Projecth

Filter matched 9 of 9 items

@ Rur Close |

EIES

o [Ecicrs -
©MakeTa =0
e e
ldlib.h

dio.h

rno.h

spe2.h

hread.h

PU : spe_program_hand
BU_THREADS
bu_pthread_function(vo
ain) « int

ne

( INFO: The simulator is PAUSED.}

Chapter 11. IDE tutorial

69



Application launcher configuration - modify the debug configuration

70

In the Main tab of the debug configuration, make sure that project PPU is in the

Project field.

For the C/C++ Application field, click Search Project.

3 €/CHt - PPU/ppU.¢ - Eclipse SDK =11
File Edit Refactor Navigate Search Project Run Window Help
rav & - R S e " = [Eeices »
|l Project Explor create, manage, and run configurations ﬁ;. e & B Make T |20
== PPU & Program not specified %8 e ¥
b @ Binaries Elih h
: it I"dw::a L L Name: [PPU ppu-gnu32-debug. | ]
& PPUARU3 [ e ilter text P e - ; = = : nah
b = spu_objs = - - || %1 Main . Target Launch' & Synchronize| % Environment % Debugger % Source ™ | lspez.h
S ppUC [E1 C/C+ 4+ Atrach to Local | hread.h
{5 5PU ¥ b C/C++ Cell Target Appl||  Project: L e prisgrain. hand
¥ Biniaries © PPU ppu-gnu?Zdeu [pPU || Browse.. U_THREADS
o €1 C/C++ Local Applicatio| = o 5 :
b o Includes o C;C-H- Pustmc::em - C/C++ Application: o u_pthread function{ve
PRSI i Anali [ | {Search Project... | Browse.. inf) : int
b @ spuc pseA L LW ]
[£ GDB Hardware Debugg
# Java Applet ¥ Connect process input _output to a terminal,
1 Java Application
o JUnit
I JUnit Plug-in Test
# 05Gi Framewark
% Remote Java Applicatio ‘,
C— T | | Apph Revert |
Filter matched 14 of 14 item L"l pevert._ ) | [
@ Jebug Close | &
g lator!)
{ INFO: The simulator is PAUSED.} {l
] I:’.':._.Ej_l

IDE Tutorial and User’s Guide Draft



Application launcher configuration - select C/C++ application

The Qualifier section lists the different build configurations that can be used (32 or
64 bit gnu, xlc, and so on). The Binaries section lists the available binaries for the
corresponding Qualifier. For the PPU project, you have not changed the default
build configuration, so only one Qualifier is currently available.

Select the PPU binary and click OK.

File Edit Refactor Mavigate Search Project By

“Program Selection

Choose a program to run:

“re o ) =
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Application launcher configuration - select target environment

72

1. Navigate to the Target tab.

2. For the Choose target field, select the simulator that was just created, then go

to the Launch tab.

€/C++ - PPU/ppu.c - Eclipse SDK

1=Tajlx]

-
file Edit Refactor Mavigate Search Project Bun Window Help

MakeTa =0
wdoe =

| | fegram_hand

ps

|_function(vo

| Create, and run ations ﬁ‘
@ [Debugger]: The CPU is not supported by selected debugger.
l= &S PPU
b & Binaries D= &3 Name: [PPU ppu-gnu32-debug
b g Includes e = 5 =
St npecany S5 g (type diter cer | | (@ Mainmrgats. Launch] = Synchronizer® Debugger s Seurcel ™
B i cpuobls FIC/C++ Attach to Local Application |- | Cell target environment:
> o ! 5
- = % C/C++ Cell Target Application Choose target: Local Cell Simulator =]
lrgenpt) - i PPU ppu-gnu32. - —
I e Sinars E1C/C++ Local Application Working directory:
e \ad% ZC/C++ Postmortem debugger # Use default
» A &b ® Eclipse Application
: ispu-gnu- ebug ©1GDB Hardware Debugging Ll f5{user. workspace}/s
il =i Java Applet | ¥ Clean up files on remote working directory after launch
7 Java Application Other options:
I Junie [ Export X11
5 JUnit Plug-in Test Please make sure that the X server:
# 05Gi Framework - was launched without: -nolisten tcp s S
T, Remote Java Application - accepts from srun “host +
SPU Timing (Std. Make Project) | e
Filter matched 14 of 14 items -
@ | Close
T INFOT TRE SIMUTEToT 15 PAUSEDLT
g—— g
0t l5 /PPU/ppu.c

IDE Tutorial and User’s Guide Draft



Application launcher configuration - configure the Launch tab

Here you can specify command line arguments as well as bash commands that are
executed before and/or after the Cell/B.E. application runs.

Next, go to the Synchronize tab.

e CiC++ - PPU/ppu.c - Eclipse SDK.
File Edit Refactor Navigate Search Preject Run Window Help
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b & Includes | o = = S 5 =
S o ppaanissadiiis [type filter text ! | /i main Terget Launch & Synchronize % Debugger & Source ™
. ‘:s e [FIC/C++ Attach to Local Application Arguments:-
& SpU_00) LY ication e | line
B ppu.c | 1| jogram_hand
=S 5PU - A1l 1bs
| o TIC/C++ Local Appli = / _
(X3 Customize application launch: funet
‘f Binaries E1C/C++ Postmortem debugger e il Unetioniye
b s Includes ® Eclipse Application Output parser:: none o 2
b e spu-gnu-debug [©/GDB Hardware Debugging Bash commands, executed before application:
b lapc = Java Applet
T Java Application
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Application launcher configuration - specify resources to synchronize

In this tab, you can specify resources (such as input/output files) that need to be
synchronized with the Cell/B.E. environment’s file system before, or after the
application runs or both.

Use New upload rule to specify resources to copy to the Cell/B.E. environment
before the application runs, and use New download rule to copy resource(s) back
to your local file system after the application has run.

Do not forget to check the Upload rules enabled and/or Download rules enabled
boxes after adding any upload/download rules.

Now go to the Debugger tab.

) C/C++ + PPU/ppu.c - Eclipse SDK.
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Application launcher configuration - select debugger and launch the

debug configuration

In the Debugger field, you can choose from Cell PPU gdbserver, Cell SPU
gdbserver, or Cell BE gdbserver.

To debug only PPU or SPU programs, select Cell PPU gdbserver or Cell SPU
gdbserver, respectively. The Cell BE gdbserver option is the combined debugger,
which allows for debugging of PPU and SPU source code in one debug session.

1. Set the Debugger field to Cell BE gdbserver.
2. Click Debug to launch the debug session.

C/C++ - PPU/ppu.c - Eclipse SDK
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Debug the application

Objectives: After you have completed this part of the tutorial you will know how
to:

* Use the debugger functions to step through your source code

The debug perspective functions in a similar way to any other GUI debugger you
have may have used in the past. You can use it to step through your Cell/B.E.
application’s source code, while you monitor variables and register values, so you
can find and fix bugs faster.

Debugl- PPU/ppu.c - Eclipse SDK
File Edit Refactor Mavigate Search Project Run Window Help
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Y n_Enrtina BBLn e dekae BLLADANE &1 I“—J
iéppncu L.Sp!..lc | =a| % Qutline = @‘&ﬂ & TSR
;m maini ; 2| = SPU_THREADS
int i; u errnoh
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Debug the application - switch to the C/C++ perspective

Switch to the C/C++ perspective. To do this:
1. Click the double right arrows at the top right
2. Select C/C++.

; ‘Debug - PPU/ppu.c - Eclipse SDK
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Dynamic profiling tool

78

Objective: After you have completed this part of the tutorial you will know how
to:

* Include the profiling functions in the spu.c code

* Run and view the results of dynamic performance analysis

Next, you see how to use the dynamic profiling tool on the SPU code.
1. Open the editor for spu.c.
2. Uncomment the 3 lines prof_clear();, prof_start();, and prof_stop();.

3. Rebuild the project by saving the source file (Ctrl+S).

File Edit Refactor Mavigate Search Project Run Window Help
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Dynamic profiling tool - change SPU modes in the simulator window

In order to use the dynamic profiling tool, the SPE’s must be in pipeline mode.

Currently the SPE’s are running in fast mode, so you need to change this.
1. Open the Simulator GUI window (systemsim-cell),
2. Click the button labeled SPU Modes.

- SUctsiseliape faipse SOK, BIE )
File Edit Refactor Mavigate Search Project Run Window Help
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- &SSPY @01 PREODD 1
» & Binaries aa PREOI Advance Cyde Amount: [~ [
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Linux console for Local Cell Simulator

[root@(none) tmp]# stty -echo =
[root@{none} tmp]# Configuration complete

[root@{none) tmp]#( INFO: Use this console to write Linux/Bash commands inside the simulator!}

{ INFO: The simulator is PAUSED.} f,
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Dynamic profiling tool - change the SPEs to pipeline mode

80

To change all of the SPE’s to pipeline mode, click the Pipe button

then go back to Eclipse.

at the bottom,
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Linux console for Local Cell Simulator

[root@(none) tmpl# stty -echo

[root@(none) tmp]# Configuration complete

[root@(none) tmpl#( INFO: Use this console to write Linux/Bash commands inside the simulator!)

{ INFO: The simulator is PAUSED.}




Dynamic profiling tool - launch the PPU application

Now that you have included the profiling functions in the spu.c code, and have
the SPE’s set to Pipeline mode, you can launch the application.

To do this, click Run » Run History » PPU.

File Edit Refactor Navigate Search Project

CiE++ < SPUIspULC - Eclipse’ SOK

| Window Help

o- |- & @ e @oev | o o [Bechy
- Project Explorer 2% ~=0lgepd g, =0z outline 1 @ MakeTa =0
ity 00 fun CrlaFil il __ Ew v
b 4 Binaries =, Debug F11 u profile.h
b & Includes t o stdioh
b = ppu-gnu32-debug s mainfunsigned leng long)
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i QSPU_ ! Debug History 3
b 4 Binaries r Debug As )
b s Includes '} 4 Open Depug Dialog...
b & spu-gnu-debug Profile History >
L B SpUL Profile As 2
@, Profile...
| External Tools >
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| Linux console for Local Cell Simulator !
[root@(none) tmp]# sty -echo

[root@(none) tmpl# Configuration complete

[root@(none) tmpl#( INFO: Use this console to write Linux/Bash commands inside the simulator!)
| ( INFO: The simulator is PAUSED.)
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Dynamic profiling tool - view the results of the dynamic performance
analysis

You can view the results of the dynamic performance analysis.

To do this:

1. Open the Simulator GUI window.
2. Expand the category SPEO

3. Open SPUStats.
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SPU timing tool - static timing analysis

Objectives: After you have completed this part of the tutorial you will know how
to:

¢ Launch the SPU Timing tool
* View data collected by the SPU Timing tool

To launch the SPU Timing tool:
1. Right click spu.c
2. Select SPU Timing » Launch SPU Timing with given parameters
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SPU timing tool - view the SPU timing output

84

You see the output from the SPU timing tool in the Console view.

Refresh your SPU project (right click SPU project, then click Refresh), to display a
new directory named sputiming, which also contains the SPU timing output.
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Simulator console - toggle the simulator console view

Objective: After you have completed this part of the tutorial you will know how
to:

* Switch between available console views

In the Console view toolbar, a small blue monitor icon is displayed. You can use
this icon to toggle between the available consoles.

Click the down arrow to the right of the blue monitor icon.
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‘stril.m “long unsigned int"
.ddent  "GCC: (GNU)} 4.1.1"
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Simulator console - select the simulator TCL console

Select the option TCL console for Local Cell Simulator.

¥ ClEt IPPU/pRU e Eclipse’SOR
File Edit Refactor Navigate Search Project Bun Window Help

r3- W | doE Broe | [0t A | & @ =
ju‘.,Praiecf Explorer 2 5% =0 @ppuc 8 @spuc
] m.n:{u:a <st=}ib|.lh>
e #include <stdio.h= - |
b 4 Binariés #include <errno.h> # SFU_THREADS al
b o Includes #include <libspez.h> u errno.h |
b & ppu-gnu32-debug #include <pthread.h> 1 libspe2.h -
v &= Spu_objs (] | (- F T
v (@ ppu.c
- &S5PU
b & Binaries
b o Includes
b = spu-gnu-debug
VB spuc :
.dbyte 0x0
.section .debug_aranges,
Jdbyte @xlc
.Zbyte 0x2
.dbyte .Ldebug_infod
.byte  @xd
.byte  0x@
2byte 6x0
2hyte  0x0
dbyte . Ltextd
dbyte . Letext@-,Ltextd
4byte Ox0
4byte
section .debug_macinfo
e 0x0
section .debug_str,"" €
. LASFO;
.string "long unsigned int"
.ident "GCC: (GNU) 4.1.1"
s _________! ol
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Simulator console - view the simulator’s TCL console

This console can be used to pass TCL commands to the simulator.

FEile Edit Refactor Mavigate Search Project Bun Window Hel

n W | |- 8 @- @- - 09 Q- | & a == A
- Project Explarer & £ & *=0|@ppuc® - @&spuc =0 Zoutline = #MakeTa =0
= S PPU | #include <stdlib.h= E 7] . v
| b & Binaries #include <stdic.h> i @‘Q 2 =

! #include <errno.h> # SPU_THREADS
b & Includes #include <libspe2.h> u errnoh
& ppu-gnuiz-debug #include <pthread.h> o libspezh o
» = 5pu_objs L C—— )
b & ppuc T Properties @ Remote Environments # SPU Timing Diagram =8
= 55PU u B B

P & Binaries |ls21320970: (3416029/1) 1 ~|0; root@{none|: ~"G|root@ none) - # modprobe systemsim_net |

» @ Includes 524095898: (344512560): FATAL: Module systemsim_net not found

b e spu-gnu-debug 524340203: (344762795): “[]0; root@ none}:~"G[root@none) ~]# ifconfig ethd 172.20.20.2 netmask

527302895: (347949387} *[1@; root@none) :~"G[root@ none) ~]# export CELLDT NET_IP SIMULATOR=172
1528157402: (348715321): ~[]0;root@{none) :~"G[root@none) ~]# export CELLDT NET IP HOST=172.20.2
1528853169: (349407668} : ~[]0; root@ none) :~"G[root@ none} -]# export CELLDT NET_MASK=255.255.255
1529556402; (350107673): ~[]0; root@(none) : —“G[root@(none) ~]# cd /tmp/

529924814: (350474664): ~[]0; root@ none):/tmp"G[root@ none) tmp)]# callthru source $CELLDT WORKD
536279341: (353159451): ~[10; root@ none):/tmp"G[root@ none) tmp]# chmod u+x configure.sh
537909338: (354917324): ~[10; root@ none): /tmp"G[root@{none) tmpl# ./configure.sh

1540407424 (357557801); Configuring SSH server

1542059279 (359357218): The "sshd" user was already configured

1621219509: (384847927): Removing password for user user.

1650446374 (390335208): passwd: Success

1695955614 (437997807): Started sshd server

696275118: (438596517): ~[]8; root@(none): /tmp*G|root@ none) tmplé

696551106: (439115428): ~[10; root@{ none): /tmp”G|root@(none) tmpl]# stty -echo

698583373: (441876188): ~[]0;root@(none): ftmp~G[root@none) tmpl# Configuration complete

{ INFO: Use this console to write TCL commands to control and inspect the simulator!)

|WARNING: 1094286777: Caught TERM Signal. Stopping Simulation |
( INFO: The simulator is PAUSED.) |!

1094286777 ** Execution stopped: Mambo Error, **
1994286777: ** finished running 575925722 instructions **
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Simulator console - use the simulator’s Linux console

You can execute Linux commands inside the simulator (as long as the simulator is

not stopped or paused).

In the Console view, switch to the console: Linux Console for Local Cell
Simulator.

File Edit Refactor Mavigate Search Project Bun Window Help

r3- S L S

[ Project Explorer &
{=&PPU
b @ Binaries
b & Includes
¥ @ ppu-gnu3z-debug
b e spu_objs
b & ppuc
= S5PU
b & Binaries
b & includes
b = spu-gnu-debug
v BspuLc

|50~ - | 4 | = n -

= E zen @ppu.cit. _n_'i:spu.c'

1 =0 %Outline & ©MakeTa =0
#include <stdlib,h= “ @-ﬂ ¥ T

#include <stdio.h> - \
#include <errno.h> # SPU_THREADS [
#include <libspe2.h> ‘ o errno.h H

#include <pthread.h> = libspe2.h

e

Problems £ Tasks © Console &2 © Properties & Remote Environments ® SPU Timing Diagram
x console for Local Cell Simulat i

[TUOLENONE | =J% EXPUIT CECLD T WURKULR=/ NUNE UAN1E (07 WOT KSPace_(esTIng;  meanat

a/ . plugins/com. ibm, celldt.environment . cellsimulator/1209069797254

[root@{none) ~1# modprobe systemsim_net

FATAL: Module systemsim_net not found.

[root@{none) ~]# ifconfig ethd 172.20.20.2 netmask 255.255.255.252 up

[root@{none) ~]# expart CELLDT_NET_IP_SIMULATOR=172.20.20.2

[root@{none) ~]# export CELLDT_NET_IP _HOST=172,20.20.1

[reot@{none) ~]# export CELLDT_NET_MASK=255,255,255,252

[root@{none) ~]# cd /tmp/

[root@{none) tmpl# callthru source SCELLDT WORKDIR/configure, sh » configure.sh

[root@{none) tmpl# chmod u+x configure.sh

[root@{none) tmpl# ./configure. sh

Configuring S5H server

The "sshd* user was already configured

Removing password for user user,

passwd: Success

Started sshd server

[root@{none) tmp]#

[root@{none) tmpl]# stty -echo

[root@{none) tmpl# Configuration complete

[root@{none) tmpl#{ INFO: Use this console to write Linux/Bash commands inside the simulator!}

( INFO: The simulator is PAUSED.}
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ALF API wizard

Objectives: After you have completed this part of the tutorial you will know how
to use the ALF API wizard to:

* Create an ALF project

* Import the generated source code and configure the projects’ properties to
include the necessary libraries and to enable embedded SPU functionality

* Modify the ALF API wizard parameters

* Create and configure a new Cell/B.E. application launcher, so that the shared
library project’s .so file (libmy_alf_project.so) can be loaded during the remote
application execution.

* Launch an ALF application

As of version 3.0, IDE includes a wizard which allows you to easily create a
Cell/B.E. application that utilizes the Accelerated Library Framework (ALF) APIL.
The ALF API provides a set of functions to a set of parallel problems on
multi-core, host-accelerator type systems, such as the Cell/B.E. processor. Features
of ALF include data transfer management, parallel task management, double
buffering, and data partitioning. The next section of the tutorial walks you through
an example use case of the ALF API Wizard.

To start using the wizard, click File »+ New » Project.

Edit Refactor Navigate Search Project Bu;l Window He
New: iso LSS =2 C Project i
Open File,.. = C4+ chject = |1%
Close Po T[] ® Project. | = 0 |z= Outline = -' MakeTa =0
Close All Shift+Ctrl+W & Convert to a C/C++ Make Project ' I_'& ol o 7
| A9 Source Folder # SPU_THREADS
'__ Save As... 4 Folder u errno.h
| - | € Source File m libspe2.h
= Header File u pthread.h
! File u stdio.h
@ Class u stdlib.h
=1 Example... ® SPU : spe_program_hand
Convert Line Delimiters To > 5 Other... = main{) : int
rint Eentry = SPE_DEFAULT_ENTRY; * ppu_pthread_function(vo

Switch Workspace >E_(untgxtnptr_1 *jarg);

| g
|2 Import. text_run(ctx, &entry, @, NULL, NULL, NULL) = 8) {
|4 Expart.. Failed running context®);

1spu.c [SPU] E(NULL);
| 2 ppuc [FPU] | = N . a
| i f L
| Exit e K5 | CONSOIR 8 T Properties % Remote Environments @ SPU Timing Diagram w B o B3¢ 70

Linux console for Local Cell Simulator
Started sshd server =
[root@(none) tmp]#
[root@(none) tmp]# stty -echo
[root@(none) tmp]# Configuration complete
[root@(none) tmp]#( INFO: Use this comsole to write Linux/Bash commands inside the simulator!)
( INFO: The simulator is PAUSED.} |]

i = 3
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ALF API wizard - start the ALF IDE wizard

1. Expand the ALF for Cell category.

2. Select the Accelerated Library Framework (ALF) API Wizard option.
3. Click Next.

a2 CiC++ - PPU/ppu.c - Eclipse SDK '?H?_ff‘
File Edit Refactor Navigate Search Project Run Window Help
i W e @ g | B0 | M L8 = [Ecicrs *
[ Project Explorer u __=ole o lisn . =o|=outline - ®MakeTa =8
i) o L S e T
5 Select a wizard — | @ i
v & PPU s s I # SPU_THREADS
b & Binari Create a new Cell BE application which utilizes the ALF API code template to — . b
It solve data parallel problems ermo.
b & Includes B o libspe2.h
Wizards:
b &= ppu-gnu32-debug ‘ u pthread.h
b & spu_objs [type hiter text | u sedioh
b & ppu.c i Java Project { u stdlib.h
= E5PU & Java Project from Existing Ant Buildfile # SPU: spe_program_hand
b & Binaries % Plug-in Project = mainl) : int
b & Includes b = General = ppu_pthread functionive
b e spu-gnu-debug = = ALF for Cell
b ESpuc Accelerated Library Framewoark (ALF) APl Wizard
= - s = (C— )|
] @ | Next> | Finish | cancel Fam| W B Bere =0
Lin — = i
Started sshd server o ' e
| [root@({none) tmp]#
[root@lnone) tmp]# stty -echo
| [root@(none) tmpl# Configuration complete

‘[root@i{none) tmpl#( INFO: Use this console to write Linux/Bash commands inside the simulator!) '
INFD: The simulator is PAUSED.) ﬂ
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ALF API wizard - enter a project name

Enter a project name, then click Next.

" CiC++ - PPUppU.C - Eclipse SDK. CIEE
File Edit Refactor Navigate Search Project Bun Window Help
r3- @ | @ e e @ | |- 0- 8- &4 o o [Eciees ~
& Project Explorer & S as ] =n/[=outline ® _© MakeTa =0
B % T | Ol
% ALF Wizard | R
=S FPU . y ; 5 # 5PU_THREADS
b & Bifiaries Create three new Cell BE projects using the ALF API wizard. The project names Py
will have the prefixes "ppu_", "spu_", and "lib". o
b & Includes M libspe2.h
b ppu-gnu3z-debug Project name: [my_alf_project u pthread.h
b @ spu_objs  Use default location wstdinly
b & ppuc — — — u stdlib.h
= B5PU testing/my. olfpr ! ® SPU : spe_program_hand
b Binaries = main() : int
b & Includes s ppu_pthread_function(vo
b @ spu-gnu-debug
b Espuc

simulator!)
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ALF API wizard - change general parameters

Here you can change the ALF IDE wizard’s general parameters. You can return to
this page at any time if you need to make any changes.

CiCHs - PRUjppi.c - Eelipss 50K

3
File Edit Refactor Mavigate Search Project Bun Window Help

{15 SR B ST < 2

1% Project Explorer 2 =noj

= S PPU
b ¢ Binaries
b & Includes
b e ppu-gnu32-debug
b G spu_objs
b @ ppuc
= 5 5PU
b ¢ Binaries
b Includes
b o spu.gnu-debug
b & spuc

Click Next.
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Ho 0B Q | & A G

ol |BCC+s

pn =0 =0utline = @ MakeTa =0
! “NEw Project = e
Baw e~
ALF Wizard General Parameters
% # SPU_THREADS
Set the ALF APl wizard's general parameters. =
o errmo.h
— o libspe2.h
Expected stack size in bytes (min=10B, max = 246KB): |10 | u pthread.h
—_— u stdioh
Expected number of accelerators: 0 (all available) % | u stdlib.h
Select partition method: fwhats_thsy Host IS | # SPU : spe_program_hand
= = = mainf) : int
Default configuration: | }Eh\_t_GﬂU_ﬂ s ppu_pthread_functionivo
| &
i | ]| B
[ ram U Ef| o B-r3v 70
Lin )
5t =
r
[
[
[E" @ <PBack | ext > Einish || cancel simulator!) H



ALF API wizard - add ALF buffers

This page displays any existing buffers, allows you to create new buffers, displays
remaining SPU local memory, and displays the data transfer entry status. Click the
corresponding What's this? text to learn more about the local memory and data
transfer status sections.

Click the Add button to create a new buffer.

.. Cic++ + PPU[ppUc - Eclipse SDK CEE
File Edit Refactor Navigate Search Project Run Window Help

- o | @ & @ e R TR R T
iy Project Explorer 8 =gl - . =0 EOutline 5 ® MakeTa | =0
Wew Project 1 e v =
Ui e
ALF Wizard Buffers i
(= S PPU Criate i kit B # SPU_THREADS
¢ i Binaries reptethe npubioutpul S u errnoh
b & Includes Hiiere # libspe2.h
¥ @& ppu-gnu32-debug e u pthread.h
» & spu_objs A g u stdioh
b @ ppuc u stdlib.h
{= &5PU ® S5PU: spe_program_hand
i Binaries = main) : int
b o Includes s

P & spu-gnu-debug
b lEspuc

[add=] Edit..| [Remove
Local Memory (accelerator}
Total (264 KB): 251904 B
Remaining: 251894 B
fwhat's_this?)

Data Transfer (DT) Entries

ppu_pthread_function(ve

17— {6l
(DT Status: NiA == a0 8- =8
. (What's_thesh

Lin E ul
5t 1=
[r

[re

[ri 0 ’

e e sBick ] e AR el CEEL e =412 g

Chapter 11. IDE tutorial 93



ALF API wizard - add the first buffer

Enter information in the fields as shown below, then click OK.

C/C++ - PPUJ| - Eclipse SDK =l=lx]

e
File Edit Refactor Mavigate Search Project Bun Wi
i~ W | Ee v @ ey | | 0 -

_ X Name: 3
| Project Explorer i h" oje D"‘.L B hsaue [mal__f B _'.’_U & Outline & - @ 1584
a < RN | i o
5 ALF Wizard Buffe Element type: 5 ol
= S PPU Cioibettiad # SPU_THREADS
b ¢ Binaries reate the input/g ] u errno.h
b Pincludes Buffers: Element unit: | ALF_DATA_FLOAT z) & Tibspe2.h
b e ppu-gnu3z-debug freeem R — T u pthread.h
b i spu_objs Buffer type: | Input buffer < | u stdio.h
b & ppuc I u stdlib.h
‘e WESPU Dimension of array: 2-D 2 | & SPU:spe_program_hand
R R = inl)+ i
dt Binaries SEeol dimensions: = main() : int .
b & Includes = ppu_pthread_functionivo
b e spu-gnu-debug 3. [eait.(rd | % [s12 | v: (1024 |z[1

b [ spu.
= ‘Local Memory (ac¢  Distribution madets: L
Total (264 KB): 25| | x; cycLic ¢ | cyCLC ¢
Remaining: 25 TTII

(What's_Ehis2)

(What's_this?)

Data Traniter (m.'l Distribution sizes:- 4
3 DTwhSrratus: HA HilLs ¥i|s1z ‘Z"“ am| Bl o @-r3- =0
\Lin Rt
5t S
s .
[
[r L
s | | Cancel | simulator!)

Eﬁi‘ m Cancel | | ]

a e 5
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ALF API wizard - add a second buffer

Use the Add button to create another buffer, enter the parameters as shown below
(use the same values as mat_a), then click OK.

Elie Edit Refactor Mavigate Search Project Run

£y i
|l Project Explorer P =n
eg
| & PPU

» ¢ Binaries

® & Includes

b o ppu-gnu32-debug

b @=spu_objs

b 4 ppuc
= 5P

b 4 Binaries

» & Includes

# e spu-gnu-debug

b & spuc

wr e @ @ |

[%-0- %

13 poseSilen:

Name;

ALF Wizard Buffg
Create the input/s

Buffers:

Name
| E—

. i

Local Memery (ac:
Total (264 KB): 25
Remaining: 21
| twhat's this?)
Data Transfer (DT
| DT Status: EQUA|
(what's_this?)

R P

[mat b
Element type:

float
Element unit: [ALF_DATA FLOAT &
Buffer type: | Input buffer

Dimension of array: | g-_D___?-__i

Size of dimensions:

x:[s12 |v[1024 z:[1
Distribution models:

X: | CYCLIC | & |¥: |CYCLIC ¢ |Z:|
e
Distribution sizes:

x:[16 | ¥ |512 Z: (1

Cancel

Type
Input Buffer

_\ | . cancel |
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= s aEpEdRE

simulator!)

ST
o [Beicks
=8=outline = ®MakeTa =B
b R
SPU_THREADS
errno.h
libspe2.h
pthread.h
stdio.h
stdlib.h
SPU : spe_program_hand
main(} : int

ppu_pthread_function(vo

6]
a B | o 8-r3- 78

[N me)

18]

95



ALF API wizard - add the third buffer

96

Use the Add button to create the third and final buffer, enter the parameters as
shown below (same values as mat_a and mat_b, except for the Buffer type), then

click OK.

CICH - PPU/pRULc - Eclipse SDK

T

Ll

File Edit Refactor Navigate Search Project Bun Wi

@ @
=552

. Project Explorer

= SPPU
b & Binaries
b & Includes
b &= ppu-gnu32-debug
b = gpu_objs
b (& ppu.c
= $5PU
b & Binaries
b & Includes
b @ spu-gnu-debug
b @spuc

r3- W | Woas

=9

|
i ALF Wizard Buffe
i Create the input/ot
i
i

Buffers:
Narme
mat_a

i mat_b

Add...| [Edit... |Rel

Local Memory (acc
Total (264 KB): 251
Remaining: 186
What's_this?)

‘Data Transfer (DT)
DT Status: EQUAL
{What's_this?)

e

| INFOT TME sImUTET

Size of dimensions:

Element type:

[foat

Elemerignless ALE DATALFLONT i)
Buffer type: | Output buffer &

Dimension of array: | 2-D ) |

x:(512 |v{102a " |z:[1 ]
Distribution models:-

¥ (Creuc [z v [orclic 2 ) z:

What's ehd)

Distribution sizes:

(16 ¥ (512

) ro—

Type
Input Buffer
Input Buffer

| Cancel |

B (@CcH -

‘=8 & Qutline sz ®MakeTa |8

Wwxoe -
SPU_THREADS
errno.h
libspe2.h
pthread.h
stdio.h
stdlib.h
SPU ;: spe_pregram_hand
main() : int
ppu_pthread_function{ve

T ea

simulator!) g

EEEes—
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ALF API wizard - finish using the ALF IDE wizard

Click Finish to complete the wizard. The wizard automatically creates and
configures the three new projects.

2 C/CH - PPU/ppU.c - Edlipse 50K
File Edit Refactor Navigate Search Project Bun Window Help

ri- W | dvoas B e | H-0- 8- Q- | & 7| G- =
Zi.b Pmiect‘ Explorer 8 =hil@ =0/ % outline s ® Make Ta 1= a
=5 - ALF Wizard Buffers @ " . -
= PPU Create the input/output buffers. & SPU THREADS
b & Binaries R o errnoh
b o Includes umelR u libspe2h
b & ppu-gnu32-debug Name ype u pthread.h
b s spu_objs mat_a Input Buffer u stdioh
b i ppuc matb Input Buer u stdlibh
- w5 5PU TR GUtpLtbutter ® SPU: spe_program_hand
b & Binaries = main{} : int
b @ includes [add...| lEd nemauej' © ppu_pthread_function(ve
b o+ spu-gnu-debug -~ S
b @ spuc Local Memory (accelerator)
Total (264 KB): 251904 B
Remaining: 153590 B
| (wehat's_this?)
Data Transfer (DT) Entries =
DT Status: EQUAL (64) b~
(i tvhat's_thist) am’
Lin
st B
" }
i
¢ @ <Back |  Mext Finis| Cancel ]
[ simulator!) E
( “IRFOTTHE SIMUTATOr 1€ PAUSED: ] E

e oSo===S—=—=——S———————  ————.—~
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ALF API wizard - ALF IDE wizard complete

98

The three new projects have now been created, the generated source code has been
imported, and the projects’ properties have been configured to include the
necessary libraries and to enable embed SPU functionality. Looking at the source
code, you notice that the ALF IDE wizard has generated code to handle many
trivial tasks, such as input/output transfer list preparation, but you must write
your own code for the computing kernel and data initialization.

File Edit Refactor Navigate Search Project Run !ﬂind Hp

-0 @6 )| g 8- @ B K Br [5v 0 Q- Qv | &1 B S o o [Eeett
[ Project Explorer = =nols spu_my._ alf_project.c VLJ ppu_my_alf_project.c = = 0|2 Outline = ~_® MakeTa | = O
- o alf_wh _dtl_end(wb_handle); 2]
B ea[l] += size[l]; ’ Wave. -
o fﬁ] zﬁ %eg:rftfdbiﬁa:;{fﬂaegtayrfsrrna buffer offset[2]); FiZe
b & Binari alf_wb_dt gl niwl e, ALF_BUF_OUT, param.c.buffer_offset PATH BUF SIZ)
ity alf_wh_dtUentry add(wb_handle, eal2], sizel2], ALF_DATA_BYTE): S SR
b & Includes alf_wb_dt1_end(wb_handle); 2Fall
b o ppu-gnu32-debug eal2] = size[2]; u common.h
b e spu_objs i alf_wb _parm_add(wb_handle, (void *)(&param), sizeof(my param_t}, ALF_DATA u libgen.h
i : sendif s ]
= & ppu_my _alf_project alf_wh_enqueue(wb_handle) : u ppu_my_alf_project.h
b & Includes } u stdioh ’
e Geommonh alf_task_finalize (task_handle); sstdiibh
b & ppu_my_alf_projecth u string.h
\T.n //TODD: Code wour application here u unistd.h
= & spu_my_alf_project ® ctx_merge_name : chai
b 4 Binaries alf_task_wait{task_handle, -1); .| ® ctx_setup_name : char|
b & Includes alf_task_destroy(task_handle); & input_dtl_name : char(’
b o spu-gnu-debug alf_exit{alf_handle, ALF_EXIT_POLICY WAIT, -1); ® kernel_name : charl]
b @i spu_my_alf_project.c return ©; ® library_name : char{l
} = ® mat_a:float{][]
& mat_b: fleat[][]

| Problems & Tasks @ Conscle = = Properties| & Remote Environments @ SPU Timing Diagram B et @y
|C-Build [ppu_my_alf_project]

#+++ Build of configuration ppu-gnu3z.debug for project ppu_my_alf_project *+++ |
Nothing to build for project ppu_my_alf_project

Writable Smart Insert 161 :37
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ALF API wizard - Create new launch configuration

Finally, you must create and configure a new Cell/B.E. application launcher, so
that the shared library project’s .so file (libmy_alf_project.so) can be loaded during
the remote application execution.

Click Run » Open Run Dialog...

E[E+ - Py LAIE BT o] ECE/ppULnTY Al 1 projectic - Ecllpse SOR

File Edit Refactor Navigate Search Project | | Window Help

o o B O Ea s Tt et g . © Toggle Breakpoint Shift+Ctri+B =
= RN o Q_" 2 n]ﬂ':gglel.ineaneakpolnl : A B.
I Project Explorer @ =0 e spu_my_alf] & Toggle Method Breakpoint =0 |&EOoutline & ® MakeTa =0

5w v 8% mggle watchpoint =l (%« o ¥
= & libmy_alf_project .f{i' 'ﬁk‘P AfiBreskpuints 3 # MY_ALIGN g
b & Binaries 2 HO emaye All ;?,at{ﬁ;{;ﬁg‘lﬂz” # PATH_BUF SIZE
b & Includes al % Bun Crrl+F11 u alfh
b o ppu-gnu3z.debug ea “ Debug Filf u comman.h
b & spu_objs it a Ig.pmﬁ;e sizeof (my_param_t), ALF_DATA u libgen.h
= ppu_my_alf_project a1 Run Histery > o ppu_my_alf_project.h
b & Includes | u stdio.h
v & common.h u stdlib.h
b @& ppu_my_alf_project.h =" Debug History 3 u string.h
| & ppumy_alf projectc |2l //TO00 Debug As » o unistd.h
= 35 spu_my_alf_project |4 ‘Open Debug Dialeg... ® ctx_merge_name : chai
b & Binaries ,]_fjﬁ: Profile History 3 = & ctx_setup_name : char|
b & Includes alf_ta  profile As > & input_dtl_name : char(’
b e spu-gnu-debug ‘M-ﬁig. Profile... ® kernel_name: charl]
b i spu_my_alf_project.c return g, External Tools > ® library_name : char(]
} = — =/ ® mat_a:fleat]][]
“ & mat_b: feat[][]
I Problems & Tasks & Console & = Properties & Remote Environments @ SPU Timing Diagram @ G oo Beorie
(C-Build [ppu_my _alf_project]
#+++ Build of configuration ppu-gnu32.debug for project ppu my alf project *+**
Nothing to build for preject ppu_my_alf_project
= Writable Smart Insert 161 : 37
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ALF API wizard - add a new upload rule

1. Create a new C/C++ Cell Target Application configuration (like you did earlier
in the tutorial).

2. Go to the Synchronize tab, then click New upload rule.

= & B | E

| Project Explorer 8

=t libmy_alf_project]
b & Binaries
b @ includes
b e ppu-gnu3z.deby
b e spu_objs
= & ppu_my _alf_projg
b o Includes
b & commeon.h
b & ppu_my_alf_pri
= i#spu_my_alf_proje
b & Binaries
b gl includes

File Edit Refactor Mavigate Search Project Run

CIs my_alf_project/ppu.my_alf_projectic - Eclipse SOK
ow Help

Create, and run -ations

@ Program not specified @
|2 = Name: [ppu_my_alf_project ppu-gnu32-debug

% Main Target| Launch & Synchronize ™ Environment % Debugger % Source ™

= I C/C++ Cell Target Appl | synchronize rules:
Upload rules are executed before application starts. Download rules are executed after
[£1C/C+ 4 Local Applicatio | application finishes.
@ Eclipse Application
5 Java Applet
[T Java Application
Ju JUnit
Jv JUnit Plug-in Test
# 05Gi Framework

® MakeTa =0
Eave-
. o
F_SIZE

-h

Falf_pmject.h

lge_name : chai
p_name : char|

1_name : charf
SPU Timing (Std. Make A LK

b s spu-gnu-debug - : ame : charl]
b @spu_my_alf_prg [ Upload rules enabietl‘l i [ Download rules enabled hame : chiari]
| New download rule | Ed Remoye selacted float{]l]
- - float(][] ol
Filter matched 10 of 10 iten ey L [—

“ @-r-=8

7] Rur | Close -

|Nothing to build for project ppu_my_alf_project

Writable Smart Insert 161 : 37

100 IDE Tutorial and User’s Guide Draft



ALF API wizard - create a new upload rule - step 2

Make sure that the option Use directory from launch configuration is checked,
then click the Workspace button.

= €T+ - ppu_my_alf_pr my_alf_project.c - Edlipse SDK
File Edit Refactor Navigate Search Project Bun Window Help

e o= " 2 La [PPSR T NUSTP N [rap ] I ;
-k & & | e @ =
a Run [x} B [

5 Project EXPIOTer | Crmate, i) oMl =
@ Program | Upload Rule @ @ ot e ¥
\= i libmy_alf_project, Please specify the remote directory and a list of files that shall be uploaded N =
b & Binaries SR Al | | JF_SIZE
b & Includes (type filter | | Remote directory: [ —
b = ppu-gnu32-debl \LYPENERET ] & Use directory from launch configuration fpource ™ h
: 2 = B GG+ por e e |
b e spu_objs mEE Remote directory: [ I
= & ppu_my_alf_proje o cicyy Selected flfs): |xecuted after _alf_project.h
b & Includes |
b & common.h @ Eclips
b & ppu_my_alf_pr¢ B jova A |
b 2 ppu_mycalf IIjava‘A.
= 35 spu_my_alf_proje JT: 13 "': ige_name ; char
b ¢ Binaries ;30;; p_name : char|
b @i Includes : = - |_name : char{
b = spu-gnu-debug | SPUTI : = 1ame : char{]
» [ spu_my_alf_prg | Options for all selected file{s): | name : char(]
I Readonly [ Executable | L lected foat(][]
[ Download back if changed O Preserve time attributes fioat{]1] &
(— S : - Reyart 537
Filter matel If file already exists: | Overwrite a7 11 ek ﬁ
| J o @i =0
@ @ | oK Cancel | | | Clogce | o~
Nothing to build for project ppu_my_alf_project H
o Writable Smart Insert 161 37
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ALF API wizard - select the shared library .so file

Expand the Workspace and libmy_alf_project categories.
Click the ppu-gnu32-debug folder to view its contents.
Check the box for libmy_alf_project.so

Click OK twice to return to the Synchronize tab.

o0 bd -

LR _CiC++ - ppu_my_alf project/ppu_my_alf_projsct.c - Eclipsa 50K
File Edit Refactor Mavigate Search Project Bun Window Help

i e B | d- uu:...n...m...‘.‘...n..um‘n-.n..\.n.._.\.m._u-.“-,_u-_.ax “'u“ - = =1 @ u
L Project Explorer 2 | craate, mi 2 (%] ® MakeTa =0
[ ngrami Upload Rule @ @ "R e T
= & libmy_alf_project] | Please N Bl

b ¢ Binaries O@x F_SIZE
i | Remote I

b & Includes [type filter | Select the ressources from workspace to add =

b = ppu-gnu32-debi type flter |l & yse d == ource ™ 1 [§:n

|| = B crcH 4l camotel [© = Workspace import_spu.mk -—l
| m B @ =5 libmy_alf_project =i ® liblibmy_alf_project.so E—becutad nfter :
[EC/C+4) Selected 2 ppu-gnu32-debug makefile ~alf_project.h
ipst] = j 114 objects.mk
2 B comminh @ Eclipsg I spu_?b}s .5 objects.m
" ( Ejava sl (e spu_abjs (L5 sources.mk
b & ppu_my_alf_pri O i
d 1iF ppu_my_alf_project

: 7 Java A
B padmy =l pre Ju JUnit b s spu_my_alf_project

= i#spu_my_alf_proje

b e spu_ohjs
= & ppu_my_alf_proje
b & Includes [

| |
-
e ‘ge_name : chai|’

b & Binaries I JUnil. bl Jp_name : char{
b @l Includes $ 056 F ™ tl_name : char{ 3
b G spu-gnu-debug | SPLT - jame : charl]
b i spu_my_alf_pr¢ Options | name : charf]
() Readd . oxeseinttey foat(]]
I Down| @ m Cancel | \Reat{](} =
Co— = i =
Filter matcl| Iffile a T i
& & OK | Cancel | | Close I» -
\Nothing to build for project ppu_my alf_project
B!
Writable Smart Insert 161 : 37

102 IDE Tutorial and User’s Guide Draft



ALF API wizard - launch an ALF application

All that remains to be done is to check the box labeled Upload rules enabled. The
libmy_alf project.so file will now be copied to the working directory automatically

before the application runs, so the PPU project executable can load it during
runtime.

Click Run to begin running the application.

Ch CJc++ < pau_my_all projectippu_my_all project.c - Eclipze SDK I
File Edit Refacter Mavigate Search Project Run Window Help
B @] B | e AR . o [EocH) -
[ Project Explorer | e o ate, manage, and run configurations ’ i f-i_"ah?'ﬁ =R
@ W= s o 7
= i libmy_alf_proj : : LIGN !
: :’ ::;:: | Name: | ppu_my_alf_project ppu-gnu32-debug | BUF_SIZE
A = > -
b e ppugnuzdf | | | |1 Main Target Launch % Synchronize % Environment % Debugger & Source ™ hon.h
b & spu_objs - & CIC++ Cell Tarqemppll Synchronize rules: i
= 35 ppu_my_alf_pr| i- ppu_my_alf_project piiiil LR AIEEE TS d before application starts. Download rules are d after ny_alf_project.h
b4 Binaries [€1C/C++ Local Applicatior | application finishes. Sl
» s Includes @ Eclipse Application UPLOAD 1 item _ o . i
- ®7 Java Applet From: libmy_alf_project/ppu-gnu32-debug/liblibmy_alf_projectso 4
b e ppu-gnu32-d = = To: ${system_workspace}/${user workspace}/$ {project_name}/${timestamp} h
b & common.h 7] Java Application s

b @ppumyalf || Tl
 ppu_my_alf_ il(f:: :!“g"“-r“; Btup_name : char]]
| TRaEWar | dtl_name : char[

ierge_name : chai)

= eEspu_my_alf_pr

b & Binaries SPU Timing (Std, Make | I_name : char(]
v & Includes g.“?!‘.’f.d..[".‘f?f.'?h!m.._..... — Downlaad sl enablad y_name : char(]
b o= spu-gnu-debt New upload rule || New download rule \ Edit selected Remove selected : float{]l]
b Lo spu_my_alf_| : float{](]

| C— 1
Filter matched 10 of 10 item

G = @-r- =0

@ H::E'Q .& pthread - =

Finished bwilding target: ppu_my alf_project

Writable Smart insert 161 : 37
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IDE PDT plugin

Objective: After you have completed this part of the tutorial, you will know how
to:

* Use the PDT to generate and view trace files

IDE provides an easy way to generate trace files using PDT - Performance
Debugging Tools. First you must set PDT flags for your project. To do this, right
click the project and choose Properties.

C/C++ - simple_spu_simd/simple_spu_simd.c - Eclipse SDK

File Edit Refactor Navigate Search Project Run PAPI Window Help

O | i G Ll B G @ [ R B (B O Q> Qe [ B v
New » :
=0/ & Outline
Open in New Window
i Copy Ctri+C M stdio
b i Binaries ther as an array of ints or as a vector. M spu_i
b @ Includes | ¥ Delete Delete & @ (anor
b e spu-gnu-d L I 0 ovecV:
b & simple_sp = main
Rename F2
& mport... ne variables
A to the 4 positions in vConst,
HAExpOrts: int){z, 2, 2, 2
Clean Project ement of vector vl
£ Refresh S {10, 20, 30, 40);
Close Project vConst.myVec );

, ¥v2[1] = wd, v2[2] = wd, v2[3] = wd\nhn",
vals[2], v2.ivals[3]);

Build Configurations. »
Make targets »
Index »

Convert To...
Run As » yperties (b Remote Environments
Debug As 3
Profile As >
Team >
Compare With »
Restore from Local History...

5 simp PDE Togls *

B EYT Properties AREater[ 0 B U/ BN |
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IDE PDT plugin - set up the C Linker flag

1. In the C/C++ Build, Settings category, go to C Linker options.
2. Select Profile & Trace.
3. Check Enable PDT compiler flags.

2 Properties for simple_spu_simd L
EileREdIER Settings
o | Cow n
= Re?uun:e Configuration: | spu-gnu-debug ~ | Manage configurations ]
& Builders ke Ta | =0
= C/C++ Build 5 =
| = simple | Discovery options ®Tool settings »Build steps  Build artifact ..Binary parsers G Error parsers

Ensironibent + ® SPU GNU Assembler & Enable POT linker flags
acaiEal
Tool chain editor = 5PUGNU C Linker

Variables ) & General
XL C/C++ Compiler = Libraries

E SIS enecal  Miscellaneous

Graject Referances #@Shared Library Settings

Refactoring History & Profila & Traca

Run/Debug Settings = Overlay

Task Repository = 1 SPU GNU C Compiler with Debug Options
& Preprocessor
& Symbols
@ Directories
= Optimization
# Debugging
& Warnings
& Miscellaneous [T
& Profile & Trace
# Architecture &=

Restore Defaults Apply

@ oK Cancel
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IDE PDT plugin - set up the C compiler flag

To set up the C compiler flag, do the following:
1. Go to C Compiler with Debug Options.

2. Select Profile & Trace.

3. Check Enable PDT compiler flags.

4. Click OK to finish.

2 Properties for simple_spu_simd
Eile Edit R type filter text Settings
O e~ Resource HCH+ ”
nfiguration:  spu-gnu-debul ¥ | Mana nfigurations| |~
3 AL Configuration: |spu-g 9 anage configurations R
= CfC++ Build = =
| & simple | Discovery options %Tool settings |~ Build steps  Build artifact .iBinary parsers o Error parsers
Environment + ® SPU GNU Assembler |0 Generate gprof information (-pg)
" n # General Generate prof information (-p}
Yool chain edlEar = % SPU GNU C Linker & Enable PDT compiler flags
Variables o
i = General
KL C/C++ Compiler & Libraries

b C/C++ General
Project References
Refactoring History
Run/Debug Settings
Task Repository

= Miscellaneous
@ Shared Library Settings
@ Profile & Trace
& Overlay
~ % SPU GNU C Compiler with Debug Options
& Preprocessor
# Symbaols
(@ Directories
2 Optimization
= Debugging
= Warnings
2 Miscellanecus

& Profile & Trace

& Architecture b

Restore Defaults Apply

Cancel

a

=5
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IDE PDT plugin - rebuild the project with PDT flags

Rebuild the project with PDT flags. The project must be built without any errors.
Now you need to create a XML configuration file for PDT.

C/C++ - simple_spu d/simple_spu_simd.c - Eclipse SDK
File Edit Refactor Navigate Search Project Bun PAPI Window Help

o | i B | @ v @ ov A8 [0 9 v (8 & v o [EeicHs] ™
=n -r,simphBU“d the active configurations of selected projects. =0 [% Outline =~ ® MakeTa =0

#include <stdio.h> | B R W e =
#include <spu_intrinsics.h> oy
= u stdio.h

/f Define a type we can look at either as an array of ints or as a vector. o spu_intrinsics.h
typedef union { =

int ivals(4]; b @ lanon‘ymouls:

vector signed int myVec; % wvecVar : union
} wvecVar;

& main() : int

int main(}) {
vecVar vl, v2, vConst; // define variables
/4 load the literal value 2 into the 4 positions in wConst,
vConst.myVec = (vector signed int){2, 2, 2, 2};
/4 load 4 values into the 4 element of vector vl
vl.myVec = (vector signed int}{10, 20, 30, 40};

[ Problems & Tasks @ Console 12 - [ Properties & Remote Environments @ G|t riv =0
C-Build [simple_spu_simd] . _ L . . ol
make all

Building file: ../simple_spu simd.c

Invoking: SPU GWU € Compiler with Debug Options

spu-gcc -DMFCIO_TRACE -Dexit=_pdt_exit -DMain=_pdt_main -DLIBSYNC_TRACE -I/opt/cell/sysroot/usr/spufinclude/
trace -00 -g3 -Wall -c -fmessage-length=8 -Winline -Wextra -fno-inline -mtune=cell -mfloat=fast -mdouble=fast -
Wno-main -march=cell -mea32 -MMD -MP -MF"simple_spu_simd.d® -MT"simple_spu_simd.d" -o"simple_spu_simd.o® *../
simple_spu_simd.c®

Finished building: ../simple_spu_simd.c

Building target: simple_spu_simd

Invoking: SPU GNU € Linker

spu-gee -Wl,-q -Wl,-N -o"simple_spu_simd® ./simple_spu_simd.o /opt/cell/sysroot/usr/spuflib/trace/libtrace.a
Finished building target: simple_spu_simd

o =5 simple_spu_simd
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IDE PDT plugin - create a PDT configuration file

To create our XML configuration file for PDT, go to File > New » Other

Edit Refacter Navigate Search P Run PAPI Window Help

N Shift+Alt+

- A o |[BECHE
Open File,.. C++ Project i, by
1 Project =0 Qutline 1 & MakeTa =0
Close Ctrl+w W
Close All Shift+Ctrl+W & Convert to a C/C++ Make Project o h
& Source Folder e e
s Folder ints or as a vector, o spu_intrinsics.h
& Source File b @ {anonymous)
& Header File @ vecVar ; union
: File = mainf) : int
@ Class
Rename... F2
Refresh 5 | Ezample... n vConst,
Conyert Line Delimiters To & Ot
signed int){18, 20, 30, 46};
function

Switch Workspace

s Import...
o4 Export...
Properties
1 test.xml [simple_spu_simd]
2 simple_spu_simd.c [simple_spu_simd]
3 test.c [test/src]
4 array_add.c [SoftCache_PPU]

Exit

trace Tuy

e

» [ vl.myVec, vConst.myVec };
]

Anvze] = wd, v2(1] = %d, v2[2] = wd, v2[3] = ad\n\n”,
als[1], v2.ivals(2], v2.ivals[3]};

Alt+Enter - -
ole 2 - O Properties & Remote Environments & e o ri~=8

_spu_simd.c

iler with Debug Options

sxit= pdt_exit -DMain= pdt main -DLIBSYNC TRACE -I/opt/cell/sysroot/usr/spu/include/
-fmessage-length=0 -Winline -Wextra -fno-inline -mtune=cell -mfloat=fast .mdouble=fast -

Wno-main -march=cell -mea32 -MMD -MP -MF"simple_spu_simd.d* -MT"simple_spu_simd.d" -o"simple_spu_simd.o™ *../
simple_spu_simd.c”

Finished building:

IE 5 simple_spu_simd
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IDE PDT plugin - open the wizard

To open the wizard, in the Performance Debugging Tool category, select
Configuration File for Cell, then click Next.

r
File Edit Refactor Mavigate Search Project Run PAPI Window Help
O | i @ | @y v @v @y R By [ By OV Qv Qv [ & ¥ = o [BCICH
& R =0 g e =0 =outline = ®MakeTa =8
= AW oW =
Select a wizard — - h"* ¢
B Fetor " . u stdio.|
This wizard creates a XML configuration file for the PDT tool using Cell B.E. as —_
the target architecture o spu_intrinsics.h
Wizards: b @ {anonymous)
type filter text @ ¥ecvar: unton
T e = maini) : int
P eCvs I
P Java
b @ Mylyn

= (= Performance Debugging Tool
Configuration File For Cell

b i Plug-in Development

* Problems & Tasks © Console 1z - & Properties & Remote Environments O Gl ot =
C-Build [simple_spu_simd]

make all

Building file: ../simple_spu_simd. c

Invoking: SPU GNU C Compiler with Debug Options

spu-gec -DMFCIO_TRACE -Dexit=_pdt_exit -DMain=_pdt_main -DLIBSYNC_TRACE -I/opt/cell/sysroot/usr/spu/include/

trace -00 -g3 -Wall -c -fmessage-length=0 -Winline -Wextra -fno-inline -mtune=cell -mfloat=fast -mdouble=fast -

Wnn-main .marchzrell .mea3? MM .MP .MF*cimnle sni cimd d* .MT*simnle sni simd d* .a*simnle sni simd n® = ¢
r 1= simple_spu_simd
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IDE PDT plugin - enter a file name

110

Select a location and a name for the XML file, then click Next.

=

File Edit Refactor Navigate Search Project Run PAPI Window Help
‘Dv!fﬁv @}@vgﬁv@vgvl

[y 0v O v |® s & |

S i

- & simple_spu_simd
b 4 Binaries
> @ Includes
b & spu-gnu-debug
b [ simple_spu_simd.c

(&
c-H

(i Project Explorer BN =0|@ g

General Options
New configuration file options

Project and file name

Project:

|simple_spu_simd || Workspace
XML file name:

[pdt.xml\

® | <Back Cancel

L

imake all
'make: Nothing to be done for ‘all'.

B |BC/CHt| »
5 %= Outline % ©Make Ta \E
&R e 7
= stdio.h
= spu_intrinsics.h
b ® (anonymous)
@ vecVar : union
e main() : int

@ B | Byrv =0

* Build of configuration spu-gnu-debug for project simple_spu_simd #+++

=
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IDE PDT plugin - select event groups

In this window you can select which event groups your PDT session will capture.
Select any event group and click Next.

2

File Edit Refactor MNavigate Search
3 v v v @v

o\‘ Civ & -
i Project Explorer = =0

-

=
b ¢ Binaries

b @ Includes

b @ spu.gnu.debug

b [2 simple_spu_simd.c

Re By [Bv OvOv Qv | & ©

Select available event group
Select which event groups will be

Available event groups:
LIBALF_PERF
LIBDACS
MFCIO
LIBDACS_SPU2
LIBOACS_PERF
LIBALF
LIBDACSZ
LIBALF_SPU
LIBDACS _SPU

I
[

cH @ =< Back

Project Run PAPI Window Help

& |0 @ |G~ gl

included in the configuration file

Selected event groups:

Add
Remove
Add all

Remove All

Cancel

make all

Building file: ../simple_spu_simd.c
Invoking: SPU GNU C Compiler with Debug Options

spu-gcc -DMFCIO_TRACE -Dexit=_pdt_exit -DMai
-¢ -fmessage- length=0

trace -00 -g3 -Wall

Wan.main _.marchzrell .meal? .MMN

Writable

. pdt_main -DLIBSYN
line -Wextra -fno-
-MP _MF*"simnle snu simd d*
Smart Insert

12:26
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5 |RCICH| *
=0 =outline s - @MakeTa =8
| e ¥
u stdio.h
= spu_intrinsics.h
b @ (anonymous)
W vecvar : union
= main() : int
® | re =0

_TRACE -ILfopt/cell/sysroot/usr/spu/include/
nline -mtune=cell -mfloat=fast -mdouble=fast -
-MTcimnle sni simd d

-n"cimnle sy simd n® = 4 I
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IDE PDT plugin - select sub-events

112

Next you need to fine tune your event selection by selecting events inside the
events groups you chose before.

Click Next when you have finished.

*

File Edit Refactor Navigate Search Project Run PAPI Window Help

w [@oicey] ~

| O~ | rav W | @ e @v ev | | © v
25 Project Explorer xz\\\ S 0|2 <
- <
- - S PDT Events Selection
~ & simple_spu_simd . .
s e Select the events that you want to trace among. Events are organized in
» # Binaries groups and subgroups.
b @i Includes

P & spu-gnu-debug
b (@ simple_spu_simd.c

General Group Options
 Enable PPE Profile
=~ Enable SPE Profile

Description
Event Group

= LIBSPE_MAIL

= LIBSPE_MFC

= LIBSPE_PROGRAM_CONTROL
= LIBSPE_MFC_STATUS

v v v v

@ | <Back

[ tec> ] |

Cancel

&z 0utline 2+ ®MakeTa | =8O

1%

L b

-
® &

stdio.h
spu_intrinsics.h
(anonymous)

vecvar : union
main() : int

@

= 8w =0

*44F BUILD OF :on?lguratwn spu—gnurﬂesug for project simple_spu_simd ****

make all
make: Nothing to be done for “all'.
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IDE PDT plugin - set colors for events

In this last step, you select different colors for the events groups, which you chose
on previous steps. This information is part of the PDT’s XML configuration file and
is used to generate PDT trace files. Click Finish to create the XML configuration
file.

2
File Edit Refacfor Navigate Search Project Run PAPI Window Help
Ov|riv . @ & @y dv @y @ R B (B O Qv Qv [ 2 e ¢ |1 B S~ div - o [moces] -
& Project Explorer =0|@ . =0z outline =z © MakeTa | = O
5 & - 3 -
— — . Groups Position and Color - e
- & simple_spu_simd s u stdio.h
ey Set position and coler of each group S
b ¢ Binaries o spu_intrinsics.h
b i Includes . = b @ (anonymous)
EventGroup name Vertical Ev Vertical Ev RGB color |
b = spu-gnu-debug ¥ wecVar : union
L i LIBSPE2 0.0 0.0 o . =
b [ simple_spu_simd.c = main{) : int
Select color.
& & bu| = =0
c.d ® < Back Cancel
make all

Building file: ../simple_spu_simd.c

Invoking: SPU GNU C Compiler with Debug Options

spu-gcc -DMFCIO_TRACE -Dexit=_pdt _exit -DMain=_pdt_main -DLIBSYNC_TRACE -I/opt/cell/sysroot/usr/spufinclude/
trace -00 -g3 -Wall -c -fmessage-length=0 -Winline -Wextra -fno-inline -mtune=cell -mfloat=fast -mdouble=fast -
Wnn-main .marchzcell .mea3? .MMD__MP _MF'simnle snu simd d® .MT*simnle snu simd A" .n"simnle snn simd n® * f v
Writable Smart Insert  12: 26

Chapter 11. IDE tutorial 113



IDE PDT plugin - modify the XML configuration file

1. Open the created XML file and set the application_name attribute to match the
binary that will be used with PDT.

2. Save the files.

3. Press F5 to refresh the workbench.

C/C++ - simple_spu_simd/pdt.xml - Eclipse SDK
File Edit Refactor Navigate Search Project Bun PAPI Window Help

Ov | riv @ @y by vy Gy (R By (B OB Qv | S & | [ Siv v © Gv :n!EE.CJC:-I-
s Project Explorer & =0 lasimple_spu_simd.c m = 0| & OQutline 2 . ® MakeTa | = O
% = [ UTF-8"7><pdt_configuration application_name="SUIICIIIMILEl output_dir="." vei -

= & simple_spu_simd An outline is not available
b ¢ Binaries
b s Includes
b & spu-gnu-debug

pdt.xmi

= 3
(L. Problems £ Tasks @ Conscle 1 - O Properties [k Remote Environments B Gl e =0
C-Build [simple_spu_simd] 2

make all

Building file: ../simple_spu simd.c

Invoking: SPU GNU € Compiler with Debug Options

spu-gcc -DMFCIO_TRACE -Dexit= pdt_exit -DMain=_pdt_main -DLIBSYNC_TRACE -Ifopt/cell/sysroot/usr/spu/include/

trace -00 -g3 -Wall -c -fmessage-length=0 -Winline -Wextra -fno-inline -mtune=cell -mfloat=fast -mdouble=fast -

Wha.main .marchzral]l .mea3? .MM LMD .MFsimnle sni simd d® .MT*simnle snn simd d® .a®simnla snn simd % % /v
Writable Insert 1:91
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IDE PDT plugin - using the Profile Launcher

You can now launch our application with PDT support. To do this:
1. Right-click the editor with the C file that will generate the executable.
2. Select Open Profile Dialog.

Oy AT bt |
File Edit Refactor Mavigate Search Project . Quick Outline
Quick Type Hierarchy Ctri+T

O | riv @ gy & v G Ry B |2

Toggle Source/Header a il
i Project Explorer = =o Show In Shift+Alt+W » =0 & Qutline = - ®MakeTa =0
S & = | #include <st R e =
- T #include <sp .
= S simple_spu_simd u stdio.h
¥ & Binaries // Define a  Ppaste Ctri+V | a vector u spu_intrinsics.h
typedef unic
» @i Includes tot Aval  Saiires P b tannnymmlsl
v = spu-gnu-debug vecz?r £ Refactor » ¥ vecvar : unicn
- b simple spu_simd.c } vecvar; i = main() : int
= Declarations ¥
o pdt.xml i i
B A ::ta;il 5 References >
// load ~ SearchText »
vConst.n
/7 load  Show Concurrency
vl.myVe¢ Selective Instrumentation »
/7 call " show 1aSTNode in DOM View
vZ.myVec
// seey Bunis ’
printf(*  Debug As > ] = sd\n\n",
return €
Team 4
2 Problems &1 Compare With 2 ® Gt B-r3
C-Build [simple_ Replace With 2 "
Preferences... i

make all
Building file:  Exclude from build...

Eg:?;‘l Eg Da;‘é‘! Build Configurations

" TRACE -L/opt/cell/sysroot/usr/spufincludes
trace -00 -g3  Make targets *line -mtune=cell -mfloat=fast -mdouble=fast -
WhA-main mare ) mrlo emi eimd A% ateimnle enn eimd A% " ¥
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IDE PDT plugin - launch the application with PDT support
1. Double left-click C/C++ Cell PDT target application to create a new launch
configuration

2. In the PDT tab, select the option Copy XML file to remote machine. You need
to configure:

116

Remote directory to copy the XML file - must be a valid directory

Local XML file. Select the configuration file you created on previous steps
Remote directory to create the trace files - must be a valid directory
Prefix for trace file name - any valid ASCII string

Local trace directory, where the generated trace files will be downloaded
from the remote environment - must be a valid directory

Click Profile to run the application with PDT support.

Ele Edit Retectof T

O~ - . s Create, manage, and run configurations = [Roces]
& Project Explorer = MakeTa | ™8O
X B B > r B o
= & simple_spu_si - Name: simple_spu_simd spu-gnu-debug
b & Binaries type filber text " Main Target Launch & Synchronize 'EQI' PDT System Environment = Commeon nsics.h
b @ Includes = C/C++ Cell PDT target application Xml configuration file info bus)
b e spu-gnu-debl = Copy XML file to remote machine © Use XML file already on remate machine nion
Parallel Performance Analysis Remote directory where XML will be copied: ht
[ pdt.xmi Performance Analysis ftmp/pdt
Local XML file:
fhome/danielhb/runtime-New_configuration/simple_spu_simd/pdt.xml Browse
Trace file info
Remote directory where the trace file will be created:
Jtmp/pdtitrace
Prefix for trace file name:
pdt_
Local trace directory: =
fhome/danielhb/temp Browse a BT
Status

Filter matched 4 of 4 items

i Profile Close

Writable Smart Isert 1013
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IDE PDT plugin - check generated trace files

After the launch finishes, you can check the results of our profiling by opening the
local directory set to receive the trace files generated.

These trace files can be viewed with the Eclipse-based VPA tool using the Trace
Analyzer perspective, for example.

2
File Edit Refactor Mavigate Search Project

O | 3w

[ Project Explorer &

i
=a
= Ssimple_spu_simd

¥ i Binaries

¥ o Includes

b = spu-gnu-debug

- B simple_spu_simd.c

o pdtxml

B 69 (v G

Bun PAPI Window Help

BT O Qv QS o odov
[& simple_spu_simd.c PR pdt.xml =0 & Outline & . & MakeTa =B
#include <stdio.h=> AR e -
#include <spu_intrinsics.h= -
= u stdio.h

/4 Define a type we can lock at either as an array of ints or as a vector u spu_intrinsics.h
typeg:{ ::;?:[f‘ - temp - b & {anonymous)

vector sign| File Edit view Places Help @ wvecVar : union
} vecVar; & mainf) : int
int main(}) { |

vecvar v, pdt_simple_ pdt_simple_

/1 load thel spu_simd- spu_simd- nst,

vConst.myVe| 200807171743 200807171743

// load 4 v 08.1 trace 08.map

vl.myVec =

/! call vec 33! ::‘.

v2.myVec = LB LI

// see what| pdt_simple_ pdt_simple_

printf("\nR| spu_simd- spu_simd- v2(3] = wd\n\n*,

v2.ivals[e]| 200807171743 200807171743

return 9; 08.maps 08.pex
¥ Eatemp ~ 4 items, Free space: 49.0 GB

: Problems & Tasks @ = 1 Properties| &= Remote Environments ® By U b

<terminated> simple_spu_simd spu-gnu-debug [C/C++ Cell PDT target application] Connection to target
* Synchronize after launch:
No rules were specified for this launch.

* Cleaning up remote working directory: /tmp/remotetools/arthas.br.ibm.com_danielhb/simple_spu_simd/121631666171

Clean up complete
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View the Eclipse preferences window
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You can view and modify numerous cell environment settings in the Preferences

window.

Click Window = Preferences...

File Edit Refactor Navigate Search Project Run |-l | Help
(i W | g e g @ |

R P.roject .Expiurer 5

=

= :élihmy_al{npro'je(t
b ¢ Binaries
b & Includes
b e ppu-gnu3z-debug
b e spu_objs

=t ppu_my_alf_project
b ¢ Binaries
b 2 Includes
b e ppu-gnu32-debug
b & common.h

& v

b & ppu_my_alf_project.h

| & ppu_my_ alf_project.c

(=t spu_my_ali_project
b & Binaries
b & Includes
b & spu-gnu-debug

EEF By A1 praject/ppi iy all Broject e Eclipse SOK

New Window

| | %+ @- o =
New Editor = - AL 7 L
= ﬂ 2 spu_my_alf_| prujé Qpen Perspective Nl =B EOutline s & MakeTa | =0
Show View s - | ””@uq.‘:
CustomuePerspectwe t;angETna;@:“ c.buffer offset[2]); | 2 ML I
- i PATH_BUF_SI
Save Perspective fs...  Fea(3) Size[2], ALF DATA BYTE); & T BUske
Reset Perspective u alfh
Close Perspective o common.h
Close Al Perspectives (d *){éparam), sizeof (my_param_t), ALF_DATA u libgenh
Navigation > o ppu_my_alf_project.h
u stdio.h
u stdlib.h
I u string.h
=} //TODD: Code your application here _| w unistd.h
& ctx_merge_name : chal
alf_task_wait{task handle, -1); ® ctx_setup_name : char|
alf_task_destroyltask handle); | ® input_dtl_name : char(:
alf_exit(alf_handle, ALF_EXIT POLICY WAIT, -1); o kernel_name : charl]

b (& spu_my_alf_project.c
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L. Problems £ Tasks

% console for Local

[root@(none) tmp]#

|[root@{none) tmp]# stty -echo

[root@inone) tmp]# Configuration complete

/[roct@(mone) tmpl#( INFO: Use this console to write Linux/Bash commands inside the simulator!)
( INFO; The simulator is PAUSED.)

16

'( INFO: The simulator is RUNNING.) |
f( INFO: The simulator is PAUSED.) H




View the IDE environment preferences

On the left side, expand the Cell category. Here you can change many different
options regarding IDE including Debug options, Cell Environment settings, and
SPU Timing binary location.

]
File Edit Refactor MNavi

3= B | g e
I Project Explorer &
= 5 lib n"l}_alf__pr‘o‘ject
b ¢ Binaries
b s Includes
b e ppu-gnuld2-debug
b @& spu_objs
= &5 ppu_my_alf_project
b 4 Binaries
b 50 Includes

b i ppu-gnu32-debug
b & common.h

b & ppu_my_alf_project

B ppU_mi roject
w i spu_my_alf_project

b & Binaries

b & Includes

b = spu-gnu-debug
b (& spu_my_alf_project,

S/E++ - Py Ao el projectipp

[type fiter texd] |
¢ General
b Ant
b CfCH+
= Debug
Cell BE
PPU
SPU
= Environment
Attached Cell Simulator
Local Cell Simulator
Remote Cell Simulator
= Managed Builder Paths
GNU Tools Managed Build
XL Tools Managed Build Pa
SPU Timing
b Help
b Installiupdate
P Java
POT
¢ Plug-in Development
b Remote Tools

» Run/Debug
b Team
@

ERronct s - Ecllpse. Sk

General Cell IDE Preferences

5DK SYSROOT Path antrceﬂrsysmot Browse... | Findit!| [my ALIGN

=
tine:t @ MakeTa =D

@uﬂa‘;

PATH_BUF_SIZE
alfh
comman.h
libgen.h
ppu_my_alf_project.h
stdio.h

stdlib.h

string.h

unistd.h
ctx_merge_name : chai|
ctx_setup_name : cha
input_dtl_name : cha
kernel_name : charl]

i
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Tutorial finished!

This concludes the IDE tutorial!
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Part 4. ALF for IDE programmer’s guide

The following topics describe how to use ALF distribution template provided by
IDE.
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Chapter 12. ALF for IDE overview

The ALF API provides a set of functions to solve a set of parallel problems on
multi-core memory hierarchy systems. This implementation of this API is focused
on data parallel problems on a host-accelerator type hybrid system. ALF offers an
interface to write data parallel applications without requiring architecturally
dependent code. Features of ALF include data transfer management, parallel task
management, double buffering, and data partitioning.

The ALF data distribution template provided by IDE, is designed to support data
parallel programming style for solving data parallel problem for arrays. Similar to
High Performance FORTRAN (HPF), the ALF data distribution template supports
three data distribution models, which are:

. *
* CYCLIC
* BLOCK

The data distributions are presented as a serial of data transfer list entries. Data
distributions provided by ALF data distribution template are for arrays of one,
two, and three dimensions.

The data distributions are applied to two types of data, which are input buffer and
output buffer.
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Chapter 13. Data distribution overview

ALF IDE introduces data distribution directives to provide you with control over
locality and data partition.

A DISTRIBUTE directive is used to indicate how data is to be partitioned among
continuous memories. It specifies, for each dimension of an array, a mapping of
array indices to accelerated nodes. Each dimension of an array may be distributed
in one of three ways:

e *: No distribution

¢ BLOCK(n) : Block distribution (default: n= N/P ), in which N is the size of array
and P is the number of accelerated node.

* CYCLIC(n) : Cyclic distribution
BLOCK distribution

Let N be the number of elements in an array dimension, and let P be the number
of accelerated nodes assigned to that dimension. Then, as illustrated in

[Figure 3|Figure 4, and [Figure 5 on page 126 a BLOCK distribution divides the
indices in a dimension into contiguous, equal-sized blocks of size N/P.

B [ [ [ HEEN
vl NONEIN

Figure 3. A 1D array BLOCK distribution for four accelerator nodes

(BLOCK, ") (*, BLOCK) (BLOCK, BLOCK)

fooderdor il 121 (5] M

Figure 4. 2D array BLOCK distributions for four accelerator nodes
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#define X 16 * 4
#lefineY 16 * 4
#define 216" 4
int ALX|[Y][Z] __ attribute ({aligned{16)));

{* BLOCK, BLOCK) o (BLOCK, *, BLOCK) o (BLOCK, BLOCK, )
X X X
4 2 v
1 - 2
= - -
Z 1 - Z - Z 1
4
4 P2 ’
-
b
1 Al L A Y

Accelerator [ T = [ ]

Figure 5. 3D array BLOCK distributions for four accelerator nodes

BLOCK(m) implies that after giving each accelerator node the array should have
been distributed; if there are any elements left over an error has occurred. It
implies that each accelerator node must get at most one block of elements

CYCLIC distribution

Cyclic distribution distributes elements of an array to processors in a round robin
fashion. If an array, A has elements N and is mapped onto P accelerator nodes,
each node gets (a maximum) total of [N / Py separate elements. See for and as
examples**WRITER COMMENT; THIS SENTENCE DOES NOT MAKE SENSE. 3D
CYCLIC distribution is inefficient and confusing and is therefore NOT supported
in the ALF data distribution template.

CYCLIC(1)
S BB BE R E »
CYCLIC(3)

- [ [ | N [ [
Accelerator . . 3 .
hodes:

Figure 6. 1D array CYCLIC distributions for four accelerator nodes
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(CYCLIC, CYCLIC) {CYCLIC, BLOCK)

foodertor [ 21 5]

Figure 7. 2D array CYCLIC distributions for four accelerator nodes

There are some limitation for CYCLIC distribution, they are:
e The memory address of each CYCLIC should be 16 Byte aligned.
* The size (Bytes) of each CYCLIC must be 1, 2, 4, 8 and integral times of 16

(instance: 1, 2, 4, 8, 16, 32 ...). Refer to the API definition descriptions for further
information.

CYCLIC(m) retains characteristics of both BLOCK and CYCLIC distributions: in
theory, blocks of m elements are grouped together which is useful for
neighborhood calculations and the cyclic distribution policy should promote a
reasonable degree of load balancing.

Practice with data distribution directives

The following topics describe how to work with data distribution directives:

* [“A matrix addition example”]

+ |A simple solution to solve the problem|

* |“Data layout and partition scheme” on page 128§|

A matrix addition example

This is a simple application that adds two 2D matrixes and stores the result to a
third matrix. For a 2D matrix addition, the mathematical definition is as follows:

C = A + B, where:

Cij = Gy *+ by
or

C S Cis L 2 fs bu bu b|,3
Car Caz Cag|T |2, far 4T b}.,| bz,z bl,ﬁ
C3) Caz Ca3| |[H3) H3; g ';:‘?,| }:’3,2 ';:‘35
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Understanding the problem
Simple solution

In the following analysis, assume the data to be a 1024 x 512 single precision
floating point matrix. The following is a sample of C code that solves the problem:
float mat_a[1024][512];

float mat_b[1024][512];
float mat_c[1024][512];

int main(void)
int i,J;

for (1=0; i<1024; i++)
for (j=0; j<b12; j++)

mat_c[i][j]= mat_a[i][j] + mat_b[i][j];
return 0;

}

The limitation with this simple approach is that it cannot run faster on a system
with many accelerators that can process the c; ; = a; ; + b; ; in parallel. There are
parallel programming languages and models that can speed up the program. The
following section describe steps to rewrite this program with ALF APIs for parallel

acceleration.
Potential solution for parallel speed increase

In general, most matrix mathematical operations can be decomposed into similar
operations on many submatrices. The operations on these submatrices can be done
in parallel if there are no dependencies between them. For example, divide the
matrix into 128 submatrices each of which has 64 x 64 elements. Then the
operation can be done on each 64 x 64 submatrix in parallel. In theory, the
computation of the 1024 x 512 matrix addition can be completed in 1/128th of the
time of the simple serialized code. The following examples use the submatrix
approach.

Data layout and partition scheme
Two dimensional matrices are usually represented in 2D arrays in C. The actual

memory layout of the 2D array in C is in 1D arrays concatenated by the
second/column index, as shown by

al,h 4 a A1,
B, 1y i o= o amr:

Figure 8. Memory organization of a 2D array "a[m]j[n]’
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—1  dAm1y 4 e s s d(m,n)

In the matrix addition example from the previous section, the submatrices were the
basic unit of data. In the above C matrix data structure, a submatrix is part of the

whole array as shown by [Figure 9| and [Figure 10 on page 130} This provides the

following options to choose from:

* Partition Scheme A: With this partition scheme, the submatrices are a part of

the whole column or row of the matrix. Or more formally, one of the
submatrices of a[m] [n] is defined as sa[h][v] where the h <m and v <= n. This
is illustrated by the
* Partition Scheme B: With this partition scheme, we define the submatrices as a
set of adjacent full length rows of the matrix. One of the submatrices of a[m] [n]
is defined as "sa[h] [v]” where the h <m and v == n. See [Figure 10 on page 130|

-\H"\'
a1 1) a0, 8l - atm
—aiz) R aEn
= amt poe - -] amd

Figure 9. Partition scheme A: Data partition of 2D sub matrix
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afl, 1 a0z e C U

U ERTURIEN BT R

= amy { - s e s | amd

Figure 10. Partition Scheme B: Data partition of 2D sub matrix

[Figure 7 on page 127 shows the differences between the two schemes. The data of
the submatrix in scheme A is collected from disjointed segments in the data buffer
of the matrix. For scheme B, the submatrix is from one contiguous segment of the
matrix. Mathematically this makes no significant difference, but the data
movement in our matrix addition example is significantly more complex in scheme
A than in scheme B, as can be seen by the following example pseudo code with
data distribution directives.

DECLARE ACCELERATE_NODES = 6;

float mat_a[1024][512];
float mat_b[1024][512];
float mat_c[1024][512];

CYCLIC(512,8) ONTO mat_a
CYCLIC(512,8) ONTO mat_b
CYCLIC(512,8) ONTO mat_c

for (i=0; i<512; ++1i)
for (j=0; j<8; ++j)

mat_c[i][j]= mat_a[i][j] + mat_b[i][J];

Based on the above analysis, scheme B is preferred in this matrix addition
example. Remember that this situation can change in some real world scenarios
where large contiguous data movement might not be supported.

IDE Tutorial and User’s Guide Draft



Chapter 14. ALF IDE wizard overview

This section describes the ALF IDE wizard.

It covers the following topics:

+ |“Basic structure of an ALF application”|
* “What does the ALF IDE wizard do?”|

Basic structure of an ALF application

The basic structure of an ALF application is shown in In general the

flow is linear.

On the host side, you first initialize the ALF runtime and then create a compute
task. After you have created the task, you add work blocks to the work queue of
the task. Then, you wait for the task to complete and shut down the ALF runtime
to free up allocated resources.

On the accelerator side, after an instance of the task is spawned, it waits for
pending work blocks to be added to the work queue. Then the alf_comp_kernel is
called for each work block. If the partition location attribute of a task is partitioned
in accelerated node, alf_accel_intput_list_prepare is called before the compute
kernel is invoked and alf_accel_output_list_prepare is called after the compute
kernel exits.

7 _Host

Initialization

Accelerator

Computing
Kemel

Deinitialization
il

Figure 11. ALF application structure and execution flow

What does the ALF IDE wizard do?

/

The ALF IDE wizard aims to release you from trivial ALF programming tasks, and
to help you focus on your problem logic.
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The ALF IDE wizard automatically generates source code for host and accelerator
code. In most cases, you only needs to add code for computing kernel and data
initialization.

The ALF IDE wizard does several tasks works automatically, as described in the
following figure.

Figure 12. Tasks performed by the ALF IDE wizard

shows that the ALF IDE wizard reduces some trivial and routine tasks,
such as initialization, and preparation of the input/output transfer list. The ALF
IDE wizard also generates the correct Makefiles for you.

The ALF IDE Wizard does not automatically generate source code for the
computing kernel and data initialization tasks. You need to generate code for your
computing kernel and data initialization.

IDE also cannot handle the data transfer list for irregular data movement. In this
case, it is suggested that you use the initialization and skeleton template for the
ALF project to generate an empty ALF project, and code your own application.

If you need to add any other libraries or headers into application, you need to
revise the project’s properties to add these dependencies.
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Chapter 15. Programming tips using the ALF IDE wizard

The following topics provide tips about how to program using the ALF IDE
wizard.

Data layout and partition scheme

Data partition is crucial to the ALF programming model. Incorrect data
partitioning and data layout design either prevents ALF from being applicable or
results in degraded performance. For the best performance, use the following
guidelines for data partitioning and data layout design.

Note: Data partition design and layout can be platform-dependent, so the best
design for one architecture might not perform well on another.

Data partition and layout is closely coupled with compute kernel design and
implementation, so you should them considered simultaneously.

* Use the correct data partition size

Often, the accelerator local memory or data cache is very limited. A significant
performance penalty can occur if the partitioned data cannot fit into this
memory limitation. For example, on Cell/B.E. architecture, if a single block of
partitioned data is larger than 128 KB, it might not be possible to support
double buffering on the SPE side. This can result in up to 50% performance loss.

¢ Minimize the number of data movements.

A large amount of data movement can cause performance loss in applications.
Improve performance by avoiding unnecessary data movements. Use the correct
data distribution size to improve the performance.

* Know address alignment limitations on specific platforms

If data is stored on aligned addresses, the processor can access it faster than data
on unaligned addresses. On platforms such as Cell/B.E., the data movement
from the local memory of the SPE can only be based on 16 byte aligned
addresses.

For more detail about data partitioning restrictions, refer to [“Data partitioning|
[limitations” on page 143

ALF host program and data transfer lists

One important decision for data transfer list is to choose whether to use accelerator
side data transfer list generation. Because there might be a large number of
accelerators used in one compute task if the data transfer list is somewhat
complex, the host might not be able to generate work blocks faster than the
accelerators can process. In this case, you can supply the data needed for data
transfer list generation in the parameters of the work block and use the
accelerators to generate the data transfer lists based on these parameters.

You can also start a new task for queuing while another task is running. You can

then prepare the work blocks for the new task in advance before the task actually
runs.
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ALF IDE wizard generates data transfer lists both in host and in accelerator
simultaneously. You can use the macro ACCELERATOR_PARTITION defined in
common.h to switch between them.

134 IDE Tutorial and User’s Guide Draft



Chapter 16. Programming with ALF IDE wizard

This section describes how to program with the ALF IDE wizard.

It covers the following topics:
+ [“Using the ALF IDE wizard to create an ALF project” on page 136|
* |“ALF IDE wizard parameters” on page 137

* [“Using user-defined types” on page 140|

+ [“Example: Matrix addition” on page 140|

© Copyright IBM Corp. 2006, 2008 135



Using the ALF IDE wizard to create an ALF project

This topic describes what you need to do to create an ALF project.

You need to follow the following steps to generate an ALF project.

1. Create an ALF project and give the project a name.

Specify the expected stack size.

Select the expected number of accelerators (1, 2, 16, and 0: for all available).
Select the partition method (host or accelerator).

A A

Describe the data distribution model for each buffer. For each new buffer input,
performing the following steps:

a. Enter the variable name, element type (the type for each element in the
buffer), and basic unit (an ALF predefined type or the same as element
type) of the element

b. Specify the buffer type (INPUT or OUTPUT)

C. Specify the dimension and size (1, ... dimension) for each dimensions of the
array

d. Specify the distribution model for this array (CYCLIC or BLOCK), and
parameters for this distribution model

6. Finish. The ALF IDE wizard generates code according to your input.
7. Revise the generated code as required.
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Create ALF Project

lInput Parameters

IDE Produces Code

Kernel

White your Gomputing

Figure 13. Creating ALF project

ALF IDE wizard parameters

Table 2. Basic user input parameters

The following table lists the user input parameters.

Token

Description

Data range

$PROJECT _NAME

Project name (Step 1)

Strings

$STACK_SIZE

Expected stack size (Step 2)

From 10 Bytes to 246 KBytes

$EXP_ACCEL_NUM

Expected number of accelerator
(Step 3)

1,2,3,4,5,6,7,8,9,10, 11, 12, 13, 14, 15, 16, and 0
for all available.

Note: All available option is invalid when any
buffer’s data distribution model is BLOCK

$PARTITION_METHOD

Partition model, host, or accelerator
(Step 4)

0 : Partition by host
1 : Partition by accelerator

$VARIABLE_NAME

Name of the data array (Step 5a)

Valid variable name in C language, it is
case-sensitive. Different buffer should have different
variable name.

$ELEMENT _TYPE

Type of element for the data array
indicated by $VARIABLE_NAME (Step
5a)

C language built in type or user defined data type.
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Table 2. Basic user input parameters (continued)

Token

Description

Data range

$ELEMENT _UNIT

Array data type. (Step 5a)

Basic data types. The choices are:

* ALF data types. There are 6 types:

ALF_DATA_INT16
ALF_DATA_INT32
ALF_DATA_INT64
ALF_DATA_FLOAT
ALF_DATA_DOUBLE
ALF_DATA BYTE

* As defined by $ELEMENT_TYPE

$BUFFER_TYPE

Buffer type of the data array
indicated by $VARIABLE_NAME. Input
buffer or output buffer. (Step 5b)

ALF_BUFFER_INPUT: input buffer
ALF_BUFFER_OUTPUT: output buffer

$NUM_DIMENSION

Number of dimension for array
indicated by $VARIABLE_NAME. (Step
5¢)

1,2,0r3

$DIMENSTON_SIZE_X

X dimension size for array indicated
by $VARIABLE_NAME.

For a 3D dimension array A, its
dimensions represented as
A[Z][YI[X]

For a 2D dimension array B, its
dimensions represented as B[Y][X]

For a 1D dimension array C, its
dimensions represented as C[X](Step
5¢)

$DIMENSION_SIZE_Y

Y dimension size for array indicated
by $VARIABLE_NAME. Only available
when the array dimension is 2 or 3.

For a 3D dimension array A, its
dimensions represented as
A[Z][YI[X]

For a 2D dimension array B, its
dimensions represented as
B[Y][X](Step 5c¢)

1, ...

0 when the dimension of array is less than 2.

$DIMENSION_SIZE 7

Z dimension size for array indicated
by $VARIABLE_NAME. Only available
when the array dimension is 3.

For a 3D dimension array A, its
dimensions represented as
A[Z][Y][X].(Step 5c)

1, ...

0 when the dimension of array is less than 3.

$DISTRIBUTION_MODEL_X

The distribution model for X
dimension of data array which
indicated by $VARIABLE_ (Step 5d)

BLOCK, CYCLIC, or *

138
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Table 2. Basic user input parameters (continued)

Token Description Data range

$DISTRIBUTION_SIZE_X | The distribution size for X CYCLIC: User input integer number, and limited
dimension distribution (indicated by |into (1 - $DIMENSION_SIZE_X). For BLOCK
$VARIABLE_NAME) for data array distribution, it is calculated by IDE as:
(indicated by $VARIABLE_NAME). (Step
5d) $DISTRIBUTION_SIZE_X = $DIMENSION_SIZE_X /

$EXP_ACCEL_NUM
x: $DISTRIBUTION_SIZE X = $DIMENSION SIZE X

$DISTRIBUTION MODEL_Y |The distribution model for Y BLOCK, CYCLIC, or
dimension of data array which
indicated by $VARIABLE_NAME Should not appear in the parameter file when the

dimension of array is less than 2.
Only available when the dimension
of data array is 2 or 3.

$DISTRIBUTION_SIZE_ Y |The distribution size for Y CYCLIC: User input integer number, and limited
dimension distribution (indicated by |into (1 - $DIMENSION_SIZE_Y). For BLOCK
$DISTRIBUTION_MODEL_Y) for data distribution, it is calculated by IDE as:

array (indicated by $VARIABLE_NAME).
$DISTRIBUTION_SIZE_Y = $DIMENSION_SIZE_ Y /
Only available when the dimension $EXP ACCEL NUM

of data array is 2 or 3.(Step 5d) : $DISTRIBUTION SIZE Y = $DIMENSION SIZE_ Y

Should not appear in the parameter file when the
dimension of array is less than 2.

$DISTRIBUTION_MODEL_Z |The distribution model for Z BLOCK or *
dimension of data array which
indicated by $VARIABLE_NAME Should not appear in the parameter file when the

dimension of array is less than 3.
Only available when the dimension
of data array is 3.(Step 5d)

$DISTRIBUTION SIZE Z | The distribution size for Z BLOCK:
dimension distribution (indicated by
$DISTRIBUTION_MODEL_Z) for data $DISTRIBUTION SIZE Z = $DIMENSION SIZE 7 /
array (indicated by $VARIABLE_NAME). | $EXP_ACCEL_NUM

*: $DISTRIBUTION SIZE Z = $DIMENSION SIZE Z
Only available when the dimension

of data array is 3.(Step 5d) Should not appear in the parameter file when the

dimension of array is less than 3.

Data partition limitations
There are some limitations for data partitions.

The partition is eventually turned into a serial of data transfer entry. The number
of these entries for each buffer after partitioning should be equal. The following
examples illustrate some valid and invalid data distributions for arrays:
A[1024][512], B[512][128].

* (CYCLIC(512), CYCLIC(16)) ONTO A, and (CYCLIC(128), CYCLIC(8) ONTO B is
valid, because the number of DT entries for these two distributions are equal.
(For A, the number of DT entry is (1024/512) * (512 / 16), and for B, the number
of DT entry is (512 / 128) * (128/6))

* (*, CYCLIC(16)) ONTO A, and (CYCLIC(128), CYCLIC(16)) ONTO B is valid,
because the numbers of DT entry for these two distributions are equal, it is 32.
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¢ (CYCLIC(512), CYCLIC(16)) ONTO A, and (CYCLIC(128), CYCLIC(16)) is
invalid, because the numbers of DT entry for these two distributions are not
equal.

The data size of each data transfer entry must be a multiple of 16 Byte (16 Bytes,
32 Bytes, and so on).

The sum of total size of buffer and free stack size should not exceed the size of
Local Storage (256 KBytes) for Cell/B.E. platform.

Using user-defined types

The ALF IDE wizard supports user-defined types. When your input is not a
C-language built-in type, the ALF IDE wizard generates a user-defined type in
common.h.

For example, when you input an array as my_structure a[1024], a struct named
my_structure is presented in common.h.

typedef
struct _my structure_t

//T0D0: Code your data structure here, make sure the size (Byte)
//of this structure is 1, 2, 4, 8 or power of 16.

char

pad[16];

}my_structure;

You can revise the structure generated by IDE as you require. You need to make
sure that the size of the structure is 1, 2, 4, 8, or power of 16 (Byte) as this is a
limitation of the Cell/B.E. platform.

The following types are treated as C programming language built-in types.

IDE supported C programming language built-in types

"char", "unsigned char", "signed char", "short", "unsigned short",
"int", "unsigned int","Tong", "signed", "unsigned","unsigned Tong",

"Tong Tong","unsigned long Tong", "float", "double", "long double",
" Bool", "float _Complex", "double _Complex", "long double _Complex"

Example: Matrix addition

The following topics describe how to code your computing kernel.

Step-by-step instructions

Refer to the [Chapter 11, “IDE tutorial,” on page 31| for a step by step walkthrough
of how to use the ALF IDE wizard.

Coding your computing kernel

You must code your computing kernel and data initialization. In this step, you
code the computing kernel in accelerated code.

By editing spu_matrix_add.c, enter the following code into alf_accel_comp_kernel.
The computing kernel will look like the following example (user-defined code is
marked as bold).
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Computing kernel for matrix addition

int alf_accel_comp_kernel(void *p_task context _ attribute
((unused)),void *p_parm_ctx_buffer,void *p_input_buffer,void
*p_output_buffer,void *p_inout_buffer _ attribute  ((unused)),unsigned
int current_count _ attribute__ ((unused)),unsigned

int total_count __ attribute__ ((unused)))

{

float *mat_a;

float *mat_b;

float *mat_c;

my_param_t *p_param = (my_param_t *) p_parm ctx_buffer;

mat_a = (float*) ((char*)p_input_buffer + p_param->c.buffer offset[0]);
mat_b = (float*) ((char*)p_input_buffer + p_param->c.buffer_offset[1]);
mat_c = (floatx) ((charx)p output buffer + p _param->c.buffer offset[2]);

//T0D0: Code your computing kernel here
int i;
for(i=0; i<p_param->c.size[0]; ++i)

mat_c[i] = mat_a[i] + mat_b[il;

return 0;

}

We will also add a data initialization code in ppu_matrix_add.c, and call it in main
()- As illustrated in the next sample and marked as bold.

Data preparation in PPU side
static void prepare_data()

{

int i, j;

for (i=0; i<1024; ++i)
for (j=0; j<512; ++j)
{

mat_a[i][j] = i *» 2.0 + j;
mat_b[i][j] = i * 3.0 + j;
mat_c[i][j] = 0.0;}

%ﬁ% main()

{

prepare_data();

alf_init(NULL, &alf_handle);

if ((err = alf_query_system info(alf_handle, ALF_QUERY_NUM_ACCEL, &nodes)) < 0)
{

fprintf(stderr, "Error in query system information\n");

return (-1);

}
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Chapter 17. Platform-specific constraints for ALF IDE Wizard
on Cell/B.E. architecture

The section describes the following platform-specific constraints:

+ [“Data distribution limitations”]

* |“Data partitioning limitations”|

* [“Local memory constraints for SPE” on page 144|

* [“User-defined type size limitations” on page 146|

Data distribution limitations

This topic describes the limitations for the various ALF data distribution policies.

For BLOCK distribution, the expected accelerator number should be exact, all
available is not allowed. This means if there has any buffer for which the
distribution model is BLOCK, the option all available options cannot be selected.

CYCLIC distribution is only available when the dimension of an array is one or
two.

Data partitioning limitations

For each array, the number of blocks after partitioning should be equal, as they are
put together into the same ALF work block. Errors occur when the number of
partitioned blocks is not equal.

The size of each block should be bound into 16 bytes (such as 16 byte, 32 byte, 48

byte, and so on). The following describes how to calculate the size of data block

after partitioning.

» data_transfer_size = sizeof (SELEMENT_TYPE) * $DISTRIBUTION_SIZE_ X, when
the array dimension is one

+ data_transfer_size = sizeof($ELEMENT_TYPE) * $DISTRIBUTION_SIZE X =
$DISTRIBUTION_SIZE_Y, when the array dimension is two

* data_transfer _size = sizeof ($ELEMENT TYPE) * $DISTRIBUTION SIZE X x
$DISTRIBUTION_SIZE_Y % $DISTRIBUTION_SIZE_Z, when the array dimension is
three

If ((data_stransfer size % 16) != 0), an error occurs.

To sum up, for ALF forCell/B.E., be aware of the following data transfer list
constraints:

* Data transfer information for a single working block can consist of up to eight
data transfer lists for each direction transfer (local store to main memory and
vice versa)

* Each data transfer list consists of up to 2048 data transfer entries

* Each entry can describe up to 16 KB of data transfer between the continuous
area in main memory and local storage

* The local store area described by each entry within the same data transfer list
must be contiguous
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* The transfer size and effective address low 32 bits for each data transfer entry
must be 16 bytes aligned

Local memory constraints for SPE

144

The size of local memory on the accelerator is 256 KB and is shared by code and
data. Memory is not virtualized and is not protected. A typical memory map of an
SPU program is given in [Figure 14 on page 145, There is a runtime stack above the
global data memory section. The stack grows from the higher address to the lower
address until it reaches the global data section. Due to the limitation of
programming languages and compiler/linker tools, you cannot predict the
maximum stack usage when you develop the application and when the application
is loaded. If the stack requires larger storage space than was allocated, there will be
a stack overflow exception. The current approach is to dedicate all the free
memory to the stack. New compiler tools also support the option to generate stack
boundary check code according to the process given in the SPU ABI document.
The SPU application will be shutdown when there is a stack overflow and a
message is sent to the PPE.

ALF allocates the work block buffers directly from the memory region higher than
the runtime stack. This is implemented by moving the stack pointer (or by pushing
a large amount of data into the stack). For ALF, the larger the buffer is, the better it
can optimize the performance of a task by using techniques such as double
buffering. It is better to let ALF allocate as much as possible memory from the
stack. Because of this, you must estimate the maximum stack usage information for
the user code plus ALF and programming language runtime code. Estimate the
stack usage and input the value into IDE. If the stack size is too small at runtime, a
stack overflow occurs and it causes unexpected exceptions such as wrong results
or a program crash. Be sure to leave enough local memory space for runtime stack
usage in the early stage of your coding and data partition designs. Reduce the
stack size to make more memory for ALF runtime usage only when the actual
requirement can be estimated more accurately.
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Figure 15. SPU local memory map - common ALF application

Because of SPE space limitations, the sum of data size partitioned into each
accelerator node and the stack size should not exceed 246 KBytes (The SPE space is
256 KB). The data size for each accelerator can be calculated as follows (for the size

of data transfer list, refer to|“Data partitioning limitations” on page 143):

sum = 0;
for_each(I0_BUFFER)
{
sum +=
data_transfer_size;
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}

sum +=
STACK_SIZE;
if (sum >246 * 1024) return error;

IDE reports an error when this limitation is exceeded.

User-defined type size limitations

The size of a user-defined type should be a multiple of 16 Bytes. IDE does not
check this.

A tip for generating a 16 byte boundary type, is to declare data structure as
follows, and the compiler will generate a data structure with a size that is bounded
into 16 bytes:

User-defined type bounded into 16 bytes
typedef struct _my_type_t

struct my_content_t

{

//Your parameters

lcs

unsigned char _pad[(sizeof(struct my type t) + 15) & OxFF10];

}
my_type_t;
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Part 5. Appendixes
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Appendix A. Related documentation

This topic helps you find related information.
Document location

Links to documentation for the SDK are provided on the IBM developerWorks Web
site located at:

|http://www.ibm.com/developerworks/power/cell/|

Click the Docs tab.
The following documents are available, organized by category:

Architecture

* Cell Broadband Engine Architecture
* Cell Broadband Engine Registers

* SPU Instruction Set Architecture

Standards

e C/C++ Language Extensions for Cell Broadband Engine Architecture

¢ Cell Broadband Engine Linux Reference Implementation Application Binary Interface
Specification

* SIMD Math Library Specification for Cell Broadband Engine Architecture

e SPU Application Binary Interface Specification

* SPU Assembly Language Specification

Programming

* Cell Broadband Engine Programmer’s Guide

e Cell Broadband Engine Programming Handbook
s Cell Broadband Engine Programming Tutorial

Library

e Accelerated Library Framework for Cell Broadband Engine Programmer’s Guide and
API Reference

* Basic Linear Algebra Subprograms Programmer’s Guide and API Reference

* Data Communication and Synchronization for Cell Broadband Engine Programmer’s
Guide and API Reference

* Example Library API Reference

s Fast Fourier Transform Library Programmer’s Guide and API Reference

* LAPACK (Linear Algebra Package) Programmer’s Guide and API Reference
* Mathematical Acceleration Subsystem (MASS)

* Monte Carlo Library Programmer’s Guide and API Reference

e SDK 3.0 SIMD Math Library API Reference

* SPE Runtime Management Library

* SPE Runtime Management Library Version 1 to Version 2 Migration Guide
* SPU Runtime Extensions Library Programmer’s Guide and API Reference

© Copyright IBM Corp. 2006, 2008 149


http://www.ibm.com/developerworks/power/cell/

150

Three dimensional FFT Prototype Library Programmer’s Guide and API Reference

Installation

SDK for Multicore Acceleration Version 3.1 Installation Guide

Tools

Getting Started - XL C/C++ for Multicore Acceleration for Linux
Compiler Reference - XL C/C++ for Multicore Acceleration for Linux
Language Reference - XL C/C++ for Multicore Acceleration for Linux
Programming Guide - XL C/C++ for Multicore Acceleration for Linux
Installation Guide - XL C/C++ for Multicore Acceleration for Linux
Getting Started - XL Fortran for Multicore Acceleration for Linux
Compiler Reference - XL Fortran for Multicore Acceleration for Linux
Language Reference - XL Fortran for Multicore Acceleration for Linux

Optimization and Programming Guide - XL Fortran for Multicore Acceleration for
Linux

Installation Guide - XL Fortran for Multicore Acceleration for Linux
Performance Analysis with the IBM Full-System Simulator

IBM Full-System Simulator User’s Guide

IBM Visual Performance Analyzer User’s Guide

IBM PowerPC® Base

IBM PowerPC Architecture” Book

— Book I: PowerPC User Instruction Set Architecture

— Book II: PowerPC Virtual Environment Architecture

— Book I1I: PowerPC Operating Environment Architecture

IBM PowerPC Microprocessor Family: Vector/SIMD Multimedia Extension Technology
Programming Environments Manual
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Appendix B. Accessibility features

Accessibility features help users who have a physical disability, such as restricted
mobility or limited vision, to use information technology products successfully.

The following list includes the major accessibility features:

* Keyboard-only operation

* Interfaces that are commonly used by screen readers

* Keys that are tactilely discernible and do not activate just by touching them
* Industry-standard devices for ports and connectors

¢ The attachment of alternative input and output devices

IBM and accessibility

See the IBM Accessibility Center at jhttp:/ /www.ibm.com/able/| for more
information about the commitment that IBM has to accessibility.
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
US.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing 2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.
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Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation

Software Interoperability Coordinator, Department 49XA
3605 Highway 52 N

Rochester, MN 55901

USA.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this information and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement, or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM’s future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

All IBM prices shown are IBM’s suggested retail prices, are current and are subject
to change without notice. Dealer prices may vary.

This information is for planning purposes only. The information herein is subject to
change before the products described become available.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
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platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs.

Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows:

© (your company name) (year). Portions of this code are derived from IBM Corp.
Sample Programs. © Copyright IBM Corp. _enter the year or years_. All rights
reserved.

If you are viewing this information in softcopy, the photographs and color
illustrations may not appear.

Trademarks

IBM, the IBM logo, and ibm.com® are trademarks or registered trademarks of
International Business Machines Corporation in the United States, other countries,
or both. These and other IBM trademarked terms are marked on their first
occurrence in this information with the appropriate symbol (* or ), indicating US
registered or common law trademarks owned by IBM at the time this information
was published. Such trademarks may also be registered or common law
trademarks in other countries. A complete and current list of IBM trademarks is
available on the Web at fhttp:/ /www.ibm.com/legal /copytrade.shtml|

Adobe®, Acrobat, Portable Document Format (PDF), and PostScript® are either
registered trademarks or trademarks of Adobe Systems Incorporated in the United
States, other countries, or both.

Cell Broadband Engine is a trademark of Sony Computer Entertainment, Inc., in
the United States, other countries, or both and is used under license therefrom.

Linux is a trademark of Linus Torvalds in the United States, other countries, or
both.

Other company, product or service names may be trademarks or service marks of
others.

Terms and conditions

Permissions for the use of these publications is granted subject to the following
terms and conditions.

Personal Use: You may reproduce these publications for your personal,
noncommercial use provided that all proprietary notices are preserved. You may
not distribute, display or make derivative works of these publications, or any
portion thereof, without the express consent of the manufacturer.

Commercial Use: You may reproduce, distribute and display these publications
solely within your enterprise provided that all proprietary notices are preserved.
You may not make derivative works of these publications, or reproduce, distribute
or display these publications or any portion thereof outside your enterprise,
without the express consent of the manufacturer.
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Except as expressly granted in this permission, no other permissions, licenses or
rights are granted, either express or implied, to the publications or any data,
software or other intellectual property contained therein.

The manufacturer reserves the right to withdraw the permissions granted herein
whenever, in its discretion, the use of the publications is detrimental to its interest
or, as determined by the manufacturer, the above instructions are not being
properly followed.

You may not download, export or re-export this information except in full
compliance with all applicable laws and regulations, including all United States
export laws and regulations.

THE MANUFACTURER MAKES NO GUARANTEE ABOUT THE CONTENT OF
THESE PUBLICATIONS. THESE PUBLICATIONS ARE PROVIDED "AS-IS” AND
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED,
INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF
MERCHANTABILITY, NON-INFRINGEMENT, AND FITNESS FOR A
PARTICULAR PURPOSE.

156 IDE Tutorial and User’s Guide Draft



Index
A

ACCELERATOR_PARTITION 133
address

alignment limitations in ALF 133

ALF
buffer 123
computing kernel 140
data distribution 125
data distribution template 123
data layout 133
data partitioning limitations 143
matrix addition sample 127
parameters 137
partitioning 133
programming tips 133
type size limitations 146
user-defined type 140
wizard for IDE 123
ALF IDE
installing templates 7
ALF IDE wizard 131
using 136
alf_accel_intput_list_prepare 131
alf_accel_output_list_prepare 131
applications
running Cell/B.E. 17
architecture
supported by IDE 5
array
in ALF 125
attached Cell/B.E. simulator 15
authentication
configuring 25

BLOCK

limitations 143
BLOCK disribution 125
buffer 123
builder path 17, 21

C

C Development Tools
see CDT 3
C/C++
cell target application 17
creating local application 17
CDT 3
XLC error parser 23
Cell/B.E. box 15
compiler
error parser 23
computing kernel 140
configuring
authentication 25
debugger 17
path 17
CYCLIC distribution 125

© Copyright IBM Corp. 2006, 2008

D

data
distribution (ALF) 125
distribution limitations 143
layout 133
partition limitations 143
transfer list 133
wizard 133
debugger
configuring 17
debugging
Cell/B.E. applications 17
creating environment 15
documentation v, 149
SDK v

E

Eclipse
installing 7
supported version 5
uninstalling 11
environment
attached Cell/B.E. simulator
Cell/B.E. box 15

15

local Cell/B.E. simulator 15

remote Cell/B.E. simulator
error parser 23

F

FORTRAN 123

G

gdbserver 27
GNU tool
path for Cell/B.E. systems
path for PPC systems 21
GNU tool chain 3

IBM Full System Simulator
see simulator 3
IDE
definition 3
limitations 27
wizard for ALF 131
XLC error parser 23
installing
ALF IDE templates 7
IDE 7
JRE 7

15

17

J

Java
supported version 5
USE_JAVA_API option 27
JRE
installing 7
JVM
installing 7

K

key 25
known issues 27

L

limitations
ALF data distribution 143
ALF data partitioning 143
ALF type size 146
BLOCK distribution 143
GDB server 27
Java API 27
localhost 27
MAC address 27
remote launch directory 27
Linux
PATH variable 7
localhost 27

M

MAC address 27

O

OpenSSH 25
operating system 5

P

parameters

ALF 137
password 25
path

configuring 17, 21
PATH variable 7
private key 25
public key 25

R

remote Cell/B.E. simulator 15
remote launch directory 27
requirements

architecture 5

Java 5

operating system 5

157



requirements (continued)
software 5

S

sample

matrix addition in ALF 140
SDK documentation 149
Secure Shell

see SSH) 25
simulator 3
software

supported by IDE 5
SPE

limitations

SPE local memory 144

memory constraints 144

SSH 25

T

troubleshooting 27

type
user-defined 140
user-defined limitations 146

U

uninstalling
ALF IDE templates 11
IDE 11
USE_JAVA_API option 27

W

work-arounds 27

X

XL tool
path for Cell/B.E. systems 17
path for PPC systems 21

158 IDE Tutorial and User’s Guide Draft






Printed in USA

SC34-2561-00



	Contents
	About this publication
	How to send your comments

	Part 1. Getting started
	Chapter 1. Overview of the IBM SDK for Multicore Acceleration Integrated Development Environment
	Chapter 2. Supported operating environments
	Chapter 3. Installing IDE
	Troubleshooting: 32–bit IES Eclipse fails to load on 64–bit Fedora 9
	Troubleshooting: 32–bit IES Eclipse fails to load on x86 with RHEL 5.2

	Chapter 4. Uninstalling IDE
	Part 2. Using IDE
	Chapter 5. Creating a Cell/B.E. environment
	Chapter 6. Running IDE on Cell/B.E. systems
	Chapter 7. Running IDE on Power-PC systems
	Chapter 8. Using the CDT XLC error parser
	Chapter 9. Configuring public key-based authentication using OpenSSH
	Chapter 10. Troubleshooting and work-arounds
	Part 3. IDE tutorial
	Chapter 11. IDE tutorial
	Getting started - open Eclipse
	Getting started - select C/C++ Perspective
	SPU project - create SPU project
	SPU project - select the C Project Wizard
	SPU project - enter the project name and define the project type
	SPU project - configure SPU Project
	SPU project - add directory the SPU compiler include paths list
	SPU project - add the directory path
	SPU project - create a new source file
	SPU project - enter the new source file name
	SPU project - edit the source file
	SPU project - automatically build the project
	PPU project - create a PPU executable project
	PPU project - create the PPU project
	PPU project - reference the SPU project - step 1
	PPU project - reference the SPU project - step 2
	PPU project - finish creating the PPU project
	PPU project - configure the PPU project
	PPU project - select the C/C++ build options
	PPU project - view the Manage Configurations window
	PPU project - add the libspe2 library to the library linker list - step 1
	PPU project - add the libspe2 library to the library linker list - step 2
	PPU project - add the SPU executable as an embed SPU input - step 1
	PPU project - add the SPU executable as an embed SPU input - step 2
	PPU project - add the SPU executable as an embed SPU input - step 3
	PPU project - configure additional settings
	PPU project - create another new source file
	PPU project - enter the name for the new source file
	PPU project - edit the source code file
	Cell/B.E. simulator - create the local Cell/B.E. simulator
	Cell/B.E. simulator - configure the simulator
	Cell/B.E. simulator - configure the simulator options
	Cell/B.E. simulator - start the simulator - step 1
	Cell/B.E. simulator - start the simulator - step 2
	Create an application launch configuration
	Application launcher configuration - create a new C/C++ Cell/B.E. target application configuration
	Application launcher configuration - modify the debug configuration
	Application launcher configuration - select C/C++ application
	Application launcher configuration - select target environment
	Application launcher configuration - configure the Launch tab
	Application launcher configuration - specify resources to synchronize
	Application launcher configuration - select debugger and launch the debug configuration
	Debug the application
	Debug the application - switch to the C/C++ perspective
	Dynamic profiling tool
	Dynamic profiling tool - change SPU modes in the simulator window
	Dynamic profiling tool - change the SPEs to pipeline mode
	Dynamic profiling tool - launch the PPU application
	Dynamic profiling tool - view the results of the dynamic performance analysis
	SPU timing tool - static timing analysis
	SPU timing tool - view the SPU timing output
	Simulator console - toggle the simulator console view
	Simulator console - select the simulator TCL console
	Simulator console - view the simulator's TCL console
	Simulator console - use the simulator's Linux console
	ALF API wizard
	ALF API wizard - start the ALF IDE wizard
	ALF API wizard - enter a project name
	ALF API wizard - change general parameters
	ALF API wizard - add ALF buffers
	ALF API wizard - add the first buffer
	ALF API wizard - add a second buffer
	ALF API wizard - add the third buffer
	ALF API wizard - finish using the ALF IDE wizard
	ALF API wizard - ALF IDE wizard complete
	ALF API wizard - Create new launch configuration
	ALF API wizard - add a new upload rule
	ALF API wizard - create a new upload rule - step 2
	ALF API wizard - select the shared library .so file
	ALF API wizard - launch an ALF application
	IDE PDT plugin
	IDE PDT plugin - set up the C Linker flag
	IDE PDT plugin - set up the C compiler flag
	IDE PDT plugin - rebuild the project with PDT flags
	IDE PDT plugin - create a PDT configuration file
	IDE PDT plugin - open the wizard
	IDE PDT plugin - enter a file name
	IDE PDT plugin - select event groups
	IDE PDT plugin - select sub-events
	IDE PDT plugin - set colors for events
	IDE PDT plugin - modify the XML configuration file
	IDE PDT plugin - using the Profile Launcher
	IDE PDT plugin - launch the application with PDT support
	IDE PDT plugin - check generated trace files
	View the Eclipse preferences window
	View the IDE environment preferences
	Tutorial finished!

	Part 4. ALF for IDE programmer's guide
	Chapter 12. ALF for IDE overview
	Chapter 13. Data distribution overview
	Practice with data distribution directives

	Chapter 14. ALF IDE wizard overview
	Chapter 15. Programming tips using the ALF IDE wizard
	Chapter 16. Programming with ALF IDE wizard
	Using the ALF IDE wizard to create an ALF project
	ALF IDE wizard parameters
	Using user-defined types
	Example: Matrix addition

	Chapter 17. Platform-specific constraints for ALF IDE Wizard on Cell/B.E. architecture
	Data distribution limitations
	Data partitioning limitations
	Local memory constraints for SPE
	User-defined type size limitations

	Part 5. Appendixes
	Appendix A. Related documentation
	Appendix B. Accessibility features
	Notices
	Trademarks
	Terms and conditions

	Index

